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★第0章、linux执行python脚本的方式
python安装路径：
	操作系统
	python版本
	安装路径

	windows
	2.7
	C:\Python27

	windows
	3.10
	C:\Users\用户名\AppData\Local\Programs\Python\Python310

	centos6
	2.6.6
	/usr/bin/python2  -->  /usr/bin/python  (可执行文件)

	centos7
	2.7.5
	/usr/bin/python  -->  /usr/bin/python2  -->  /usr/bin/python2.7   (可执行文件)

	centos8
	3.6.8
	/usr/libexec/platform-python  -->  /usr/libexec/platform-python3.6  (可执行文件)



①进入交互模式
# python                            #输入python回车，也可直接输入python2（指定大版本为2）
>>>                                #这里可执行python代码，类似shell脚本
>>> print("hello")
>>> exit()                            #退出交互模式

②执行一次性代码
# python2  -c  "要执行的代码，多个语句之间用;分号隔开"


③执行脚本
# vi  test.py                         #内容如下3行
#!/usr/bin/env python
# -*- coding: UTF-8 -*-
print("hello world")

# chmod  +x  test.py                 #添加可执行权限
# python2脚本文件里要指定以下2行作为开头
#!/usr/bin/env python
# -*- coding: UTF-8 -*-

# ./test.py                            #执行脚本
#或者
# python2  test.py



★第1章、PyCharm常用设置
PyCharm官网： https://www.jetbrains.com/pycharm/download/
旧版本下载： https://www.jetbrains.com/pycharm/download/other.html

★PyCharm快捷键
	Alt + Shift
	列选择模式，可同时选择多列

	Ctrl + Alt + L
	重新格式化代码，Reformat Code

	Ctrl + B
	跳转到鼠标指定的函数定义处

	Shift + F10
	运行程序

	Ctrl + R
	查找替换

	Ctrl + /
	批量注释或取消注释（选中的所有行）

	Shift + Enter
	直接创建新行，并跳到新行（会自动根据上下文进行缩进）

	Ctrl + Shift + +
	展开当前代码文件的所有代码块

	Ctrl + Shift + -
	折叠当前代码文件的所有代码块

	Ctrl +  +
	展开当前代码块（光标所在位置）

	Ctrl +  -
	折叠当前代码块（光标所在位置）




★设置快捷键
File → Settings → Keymap → 搜索 "to line end"，编辑Move Caret to Line End的快捷键为 Alt+L
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★设置字体颜色
File → Settings → Editor → Color Scheme → Language Defaults → 选中目标Scheme
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★设置背景颜色
File→Settings→Editor→Color Scheme→Console Colors→Scheme → 选择合适的主题
[image: ]


★设置编程界面代码显示主题
File→Settings→Appearance & Behavior→Theme：选择一个合适的主题，也可点击“get more themes”下载更多主题
[image: ]


★显示空白字符
File → Settings → Editor → General → Appearance → 选中Show whitespaces
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★不进行拼写检查
File → Settings → Editor → Inspections → Proofreading → Typo 取消勾选
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★设置项目的python解释器
File → Settings → Project: xxx →Python Interpreter → 右侧选择目标python解释器
[image: ]


★关闭双击shift全局搜索功能
有时我们使用shift切换输入法，若不小心按的次数多了（按2次shift键），结果就弹出全局搜索框，不太友好，可以关闭此功能
File → Settings → Advanced Settings → 右侧的 User Interface ，勾选 Disable double modifier key shortcuts
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★设置每行最大长度
File → Settings → Editor → Code Style → 右侧的 General下的 Hard wrap at: 120（默认为120字符）
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★设置源码文件字符编码
File → Settings → Editor → File Encodeings → 右侧的“Global Encoding”设置目标字符编码，默认UTF-8
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★pycharm设置代理
通过代理进行模块的安装
File → Settings → Appearance & Behavior → System Settings → HTTP Proxy
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★设置缩进为4空格
File → Settings → Editor → Code Style → Python → Tabs and Indents：
取消勾选“Use tab character”，设置Tab size为4，Indent为4
[image: ]




★第3章、基础语法
★保留字（关键字）
	and
	as
	assert
	break
	class
	continue

	def
	del
	elif
	else
	except
	exec

	finally
	for
	from
	global
	if
	import

	in
	is
	lambda
	not
	or
	pass

	print
	raise
	return
	try
	while
	with

	True
	False
	None
	
	
	yield



可以使用以下命令查看：
import keyword
print(keyword.kwlist)

注意：
print 在py2中是关键字，在py3中不是关键字，是一个函数
None 在py2.0设计之初就锁定为关键字（虽然它不在keyword.kwlist里）
True/False是py2.3才正式引入的常量（内置常量），此前用1/0表示bool值，所以py2.x中True/False不是关键字，可被修改




★标准数据类型
py2只有5个标准数据类型：number、string、list、tuple、dictionary

	number
	int  bool  float  complex ( 1+2j )        （python3无long长整型）    True=1, False=0

	string
	有序  strx='xxxx'   stry="xxx"            不区别单引号与双引号，单个字符也是string

	list
	有序  列表，数组

	tuple
	有序  元组

	dictionary
	无序  字典 {键值对 集合}   关键字必须互不相同



不可变类型（immutable）： Number   String       Tuple
可变类型（mutable）：     List       Dictionary

①python中的bool值也算是number数值，True等于1，False等于0
if True == int(1):
    print("True is 1")
else:
    print("True is not 1")
结果：
True is 1

python2中的8进制数是以数字0开头的，比如：  num=0775
而py3中的8进制数是以 0o开头的，比如：  num=0o775    （py2.6+也支持这种写法了）



★判断变量类型
type(x)               #返回x的类型，如 <class 'int'>
isinstance(x, int)        #返回True或False

type()不会 认为子类是父类的一种类型
isinstance(x,int)会认为子类是父类的一种类型



★类型转换
	map(type, listxx)
	将字符串str型list转为int型list
strlist = ["23","15","6","44"]             #元素类型为str
strnn = list(map(int, strlist))             #map()将strlist的元素都转为int型，map()返回的是map类型，需要再使用list()转为list型
tuple(map(int, strlist))                  #返回tuple型

	int(x)
	将x输出为10进制的整型，这里的x为number

	int(x,base=n)
	将x输出为10进制的整型，这里的x必须是n进制的string型
如  int("A", base=16)返回值为10

	chr(n)
	输入0～255内的整数，返回对应ascii字符，输入可为10进制，也可为16进制

	unichr()
	输入任意unicode编码值（整数），返回对应unicode字符

	ord('x')
	输入为一个字符，ascii及unicode字符都行，输出为对应的int编码值
unicode字符必须在前面加字母u，如  print(ord(u"我"))

	hex()
	将一个整型数字转为16进制字符串，0xnn

	oct()
	将一个整型数字转为8进制字符串，0onn

	bin()
	将一个整型数字转为2进制字符串，0bnn






★python2的字符编码注意事项
①python2.x解析.py文件时，默认是按ascii码读取的，若代码文件中有汉字等其他非ascii字符，会抛出以下异常：
SyntaxError: Non-ASCII character '\xe6' in file xxxxxx.py on line 3, but no encoding declared;

此时，需要显式指明源码文件的编码方式：
#!/usr/bin/env python
# -*- coding: UTF-8 -*-

# -*- coding: UTF-8 -*-
import sys
print(sys.getdefaultencoding())         #查看内置默认编码
结果：
ascii


②python2中的string类型，其值默认是“字节码”，相当于py3中的bytes，无固定编码，其编码由源码文件决定，如：
# -*- coding: UTF-8 -*-
str_xx = "汉字"   # py2中的str默认就是字节码，也可在其前面加字母b，如 b'ABC'，但默认就是加了字母b
print(type(str_xx))
print(repr(str_xx))
结果：
<type 'str'>
'\xe6\xb1\x89\xe5\xad\x97'          #utf8字节码

# -*- coding: GBK -*-
str_xx = "汉字"
print(type(str_xx))
print(repr(str_xx))
结果：
<type 'str'>
'\xba\xba\xd7\xd6'                #GBK字节码


③python2中的string类型若要指明其编码为utf8，可在字符串前加字母u，如：
# -*- coding: GBK -*-
str_xx = u"汉字"
print(type(str_xx))
print(repr(str_xx))
结果：
<type 'unicode'>                   #此时类型也由str变成了unicode
u'\u6c49\u5b57'                   # utf16字节码


★实操建议
1、所有.py源码文件开头都添加  # -*- coding: UTF-8 -*-
2、所有字符串值前面都加u声明为unicode类型，避免使用字节串，如 str_xx = u"xxx"
3、输出str类型字符串时，显式使用 strxxxx.decode("utf-8") #字节转unicode
4、读写文件时必须显式指定编码 open('test.txt', 'r', encoding='utf8')
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★str字符串操作
引号与三引号
字符串可以用  引号 括起来，单个字母也是字符串，如下：
str_xx = "a"
str_yy = 'b'
如果引号里还有相同的引号，则需要使用\反斜杠转义
str_xx = "hello, i am \"cof-lee\""
print(str_xx)
结果：
hello, i am "cof-lee"

注意：
py2中的string类型，其值默认是“字节码”，相当于py3中的bytes，无固定编码，其编码由源码文件决定


3个引号（可以是3个单引号，也可以是3个双引号，一般建议只用3个双引号）表示多行注释，比如：
def funcxx():
    """
    这里是多行注释
    本函数实现了xxx功能
    :return: 
    """
    print("test")

3个引号也可以做字符串，多行字符串，（可包含 "双引号及'单引号，而不需要使用\反斜杠进行转义）
str_nn = """this is\n "hello" \t 'world'
lslslslslslsls
llllllllllllll
"""
print(str_nn)
结果：（根据结果可知，三个引号里面的\反斜杠也会进行转义）
this is
 "hello" 	 'world'
lslslslslslsls
llllllllllllll

如果不想让字符串里的\反斜杠转义，可以在字符串前加字母r或者R（表示row原始字符串），或者写双反斜杠\\
str_nn = r"""this is\n hello \t world"""
str_nn2 = """this is\\n hello \\t world"""
print(str_nn)
print(str_nn2)
结果：
this is\n hello \t world
this is\n hello \t world



大小写转换及替换过滤拆分拼接-相关操作
strx="what cAnd Wfds sfjdsD"
strx.lower()           #全转为小写，返回新的字符串，不改变原字符串
strx.upper()           #全转为大写，返回新的字符串，不改变原字符串
strx.capitalize()        #句首字母大写
strx.title()             #将每单词首字母大写
strx.swapcase()         #全部大小写翻转，互换

strx.replace("old", "new")        #把strx中的old替换成new
strx.rstrip()                   #过滤掉换行符及行尾的所有空白符
strx.lstrip()                   #过滤掉行首的所有空白符
strx.strip()                    #过滤位于行首以及行尾的所有空白字符以及换行符

strx.split()                    #将strx拆分，默认以空白符（含换行符）为拆分符
strx.split(" ")                  #将strx拆分，""之间指定拆分符
strx.split(" ", 1)                #将strx拆分，""之间指定拆分符，且只拆分1次，即分成2部分

strx.isdigit()                   #判断strx是否为纯数字字符，是则返回True，否则返回False
strx.isalpha()                  #判断strx是否为纯字母字符，是则返回True，否则返回False（仅大小写字母）
strx.islower()                  #判断strx是否为小写字母字符，是则返回True，否则返回False
strx.isupper()                  #判断strx是否为大写字母字符，是则返回True，否则返回False
strx.isalnum()                 #判断strx是否为字母或数字字符，是则返回True，否则返回False

lists=["abc","def","what"]
strx="".join(lists)        #默认直接拼接可遍历的对象，元素只可为str，中间不会加入其他字符或删除其他字符
stry=",".join(lists)       #拼接时在2元素str间添加 ""引号中指定的符号，这里是添加逗号

strx = "hello"
newstrc = strx.center(30, "*")  # 输出总字符数30，strx显示为居中对齐，其余空位使用""引号中指定的*补全
newstrl = strx.ljust(30, "*")      # 左对齐，*补全
newstrr = strx.rjust(30, "*")      # 右对齐，*补全


import re

src_str = """select * from ? where name='?' and age=?; [student,cof,18]"""
match_obj = re.search(r'\[(.*?)\]', src_str)

sql_str = src_str[0:match_obj.start()]
print("origin sql: ", sql_str)

param_str = src_str[match_obj.start():]
param_str = param_str.replace("[", "")
param_str = param_str.replace("]", "")
param_list = param_str.strip().split(",")  # 到这一步，已经将方括号里的所有参数转为 str 的列表了
print("param_list: ", param_list)

new_sql_str = sql_str.replace('?', '%s').replace('%s', '%s', len(param_list) - 1) % tuple(param_list)

print(new_sql_str)
结果：
原始sql语句:  select * from ? where name='?' and age=?; 
识别到的参数list:  ['student', 'cof', '18']
select * from student where name='cof' and age=18; 




★十六进制字符串与str字节串互换

# 十六进制字符串 转为 bytes
# -*- coding: utf8 -*-

hex_str = "414243"  # 十六进制字符串
byte_str = hex_str.decode("hex")  # hex字符串转为str(bytes)
print(type(byte_str))
print(repr(byte_str))
print(len(byte_str))
结果：
<type 'str'>
'ABC'
3

# bytes 转为 十六进制字符串
# -*- coding: utf8 -*-

str_xx = 'ABC'  # py2中的str默认就是字节码，也可在其前面加字母b，如 b'ABC'，但默认就是加了字母b
byte_str_xx = str_xx.encode("hex")  # 将str转为字节码，结果仍然是存放到str类型的变量里，py2只有str
print(byte_str_xx)
print(len(byte_str_xx))




★运算符

①算术运算符
+    -    *    /
%      取模，取余数
**     幂，如 A ** 4   表示A的4次幂
//     取整除，取商的整数部分，向下取整，去尾法；若运算数为float，则结果也是flost

②比较运算符
==    等于        !=    不等于
>     大于        >=    大于等于
<     小于        <=    小于等于

③逻辑运算
not    and    or

★链式比较
if 3 > 2 == True:
    print("yes")
else:
    print("no")
结果：
no

原因是python会将 3 > 2 == True拆解为  3 > 2  and  3 == True: 结果是False



④成员运算
in                       # a  in  Listx ;    a在Listx中则返回True
not  in                  # a  not  in  Listx ;    a不在Listx中则返回True

⑤身份运算符
is                       # a is b ;    判断a和b是否引用自同一个对象，是则返回True
is  not
# a is b 同 id(a) == id(b)              # id(x)用于获取对象x的内存地址


⑥位运算符
&      与运算       ^  异或
|       或          <<  左位移
~       取反        >>  右位移


★运算符优先级：
指数**  > 位运算 > 乘除 > 加减 > 比较 > 赋值 > 身份 > 成员 > 逻辑




★整除运算
在python 2中，/ 如果参与运算的数为int，就是整除，只取整数
如果 / 参与运算的数为float，则返回float，不再是整数

如果要保证能返回整数，需要强制转为int，才保险一些，如：
a = 4.8
b = 2
c = int(a / b)
print(c)
结果：
2

也可用 import math ;  math.trunc(xx/yy) 来取整，(xx/yy)可为float，结果也是整数商
import math

a = 9
b = 2.9
c = math.trunc(a / b)
print(c)
结果：
3




★小数取整
①内置函数round()为四舍五入，n.5则向上取整
round(2.5)            #返回3
round(3.5)            #返回4

②math.ceil() 进一法
import math
math.ceil(3.1)           #返回4

③math.floor() 去尾法
import math
math.floor(3.99)         #返回3




★条件语句
（python<3.10版本不支持switch语句，在3.10版本开始支持switch语句）
if  判断句 :
    语句体
elif  判断句 :
    语句体
else:
    语句体




★循环语句
① for循环
for  i  in  xx :                   # xx为可遍历的数据，如list,tuple,bytes,bytearray
    break                       #跳出当前循环，跳出for

#使用索引：
for  i  in  xrange(10) :            #生成10个数，从0开始，0到9
    # To Do

# range(1,9)                     #从1开始，1到8
# xrange(1,9,2)                    #从1开始，步长为2，即1，3，5，7

注意：
py2中的 range()是列表生成器，得到的是一个列表；xrange()是惰性迭代器
优先使用xrange()做循环迭代，节省内存且速度更快
py3只有range了（但py3的range就是py2中的xrange）
# -*- coding: utf8 -*-
ll = range(5)
print(ll)
print(type(ll))
xx = xrange(5)
print(xx)
print(type(xx))
结果：
[0, 1, 2, 3, 4]
<type 'list'>
xrange(5)
<type 'xrange'>

②while循环
while 判断 :
    循环体
    continue             #continue跳过剩下的循环体，进入下一轮loop，break跳出整个循环




★二维list
直接定义：
matrix = [[0, 0, 0], [0, 0, 0], [0, 0, 0]]

间接定义：
matrix = [[0 for i in xrange(3)] for i in xrange(4)]  # 4个小list，每小list为3元素（4行3列）
print(matrix)

matrix = [0 for _ in xrange(10)]  # 下划线表示占位符，如果写 i，有时会提示i未被使用
print(matrix)

三维类推：
matrix = [[[0 for _ in xrange(3)] for _ in xrange(4)] for _ in xrange(2)]
print(matrix)


#查看数组行数与列数
arr = [[1, 2, 3], [4, 5, 6], [7, 8, 9], [10, 11, 12]]
print(len(arr))                # 行数
print(len(arr[0]))             # 列数




★list/dictionary增删改查操作
①list数据操作（有序，数值可重复）
listxx.append(x)              # 把元素x追加到列表的末尾
listxx.insert(i, x)           # 在索引i指定位置插入元素x，原listxx[i]后移一位
listxx.extend(listyy)         # 把listyy追加到列表的末尾
listxx.remove(x)          # 删除列表中第一个值为x的元素，若无这样的元素则返回一个error
listxx.pop(i)      # 从列表的指定索引位置移除元素，并返回此元素值，如果不指定i，则移除并返回最后一个元素
listxx.popleft()          # 移除列表头元素并返回其值
listxx.index(x)           # 返回列表中第一个值为x的元素的索引
listxx.count(x)           # 返回x在列表中出现的次数
listxx.sort()  #对列表中的元素排序，改变列表本身，返回值为None或error，不返回新的list，默认升序，从小到大
listxx.sort(reverse=True)      # 排序，降序，从大到小
listxx.reverse()               # 反转列表，头变尾，尾变头
del listxx[1:3]                # 切割操作，删除列表的这一段，含头不含尾
newlist = sorted(listxx)       # 返回新列表，且排好序了，升序，原listxx不变

# -*- coding: utf8 -*-

list_xx = ["a", "b", "c"]
for i, item in enumerate(list_xx):  # 返回索引及相应的元素
    print("第 {} 个元素为 {}".format(i, item))
结果：
第 0 个元素为 a
第 1 个元素为 b
第 2 个元素为 c

对列表排序（当列表的元素为tuple时）：
users = [("cof", 18),
         ("lee", 19),
         ("wong", 17),
         ("tom", 20),
         ("duck", 16)
         ]
new_users = sorted(users, key=lambda x: x[1])
# users.sort(key=lambda x: x[1])  #对自己排序也一样的
print(new_users)
结果：
[('duck', 16), ('wong', 17), ('cof', 18), ('lee', 19), ('tom', 20)]


②dictionary数据操作（无序，key不重复）
dictxx["new_key"] = "new_value"      # 新增键值对，如果已存在则更新值
dictxx.update(lx)                #添加多个键值对，lx为另一dictionary
value2 = dictxx["k2"]            # 取指定key对应的值
k,v=dictxx.popitem()             # 随机返回并删除一个键值对
del dictxx["k2"]                  # 删除指定key的这对键值对




★遍历字典dictionary
①遍历key
dictx = {"k1": "v1", "k2": "v2", "k3": "v3"}
for key in dictx.keys():
    print(key, "-------->", dictx[key])

#判断字典中是否存在某个key
dictx = {"k1": "v1", "k2": "v2", "k3": "v3"}
if "k3" in dictx.keys():
    print(dictx["k3"])
else:
    print("k3不存在字典中")

dictx = {"k1": "v1", "k2": "v2", "k3": "v3"}
value = dictx.get("k3")  # 如果key不存在，则默认返回None
if value is None:
    print("k3不存在字典中")
else:
    print(dictx["k3"])

dictx = {"k1": "v1", "k2": "v2", "k3": "v3"}
value = dictx.get("k33", "null")  # 如果key不存在，则返回指定的值"null"
print(value)


②遍历value
dictx = {"k1": "v1", "k2": "v2", "k3": "v3"}
for value in dictx.values():
    print(value)

③遍历item
dictx = {"k1": "v1", "k2": "v2", "k3": "v3"}
for k, v in dictx.items():
    print(k, "---->", v)

访问字典下的子字典：
dict_xx = {
    "key1": "value1",
    "key2": {
        "subkey1": "xxx",
        "subkey2": [
            {
                "subsubkey1": "yyy",
                "subsubkey2": "zzz"
            },
            {
                "subsubkey3": "nnn"
            }
        ]
    }
}
print(dict_xx["key2"]["subkey2"][0]["subsubkey1"])
结果：
yyy

dict_xx = {
    "key1": "value1",
    "key2": "value2"
}
try:
    value = dict_xx["key2"][0]["subsubkey11111"]
    print(value)
except KeyError:
    print("dict_xx 没有指定的key")
except TypeError:
    print("dict_xx['key2']不是一个序列")
except IndexError:
    print("dict_xx['key2']没有指定的索引[1]")
结果：
dict_xx['key2']不是一个序列




★深拷贝和浅拷贝
深拷贝：
deep copy深拷贝是完全复制一个对象，包括对象里的可变类型数据
# -*- coding: utf8 -*-

import copy

ori_obj = {"mylist": [1, 2, 3]}
new_obj = copy.deepcopy(ori_obj)
new_obj["mylist"].append(4)  # 对新对象的操作，不会影响到原始对象的内容

print("ori_obj: {}".format(ori_obj['mylist']))
print("new_obj: {}".format(new_obj['mylist']))
结果：
ori_obj: [1, 2, 3]
new_obj: [1, 2, 3, 4]


浅拷贝：
shallow copy浅拷贝会复制一个新的对象，但对于原对象里的可变类型数据，它只复制了引用，并未完全复制其内容本身，所以对新的对象的操作，会影响到原始对象里的可变类型的数据
# -*- coding: utf8 -*-

ori_obj = {"mylist": [1, 2, 3]}
new_obj = ori_obj.copy()
new_obj["mylist"].append(4)  # 对新对象的操作，会影响到原始对象的内容
print("ori_obj: {}".format(ori_obj['mylist']))
print("new_obj: {}".format(new_obj['mylist']))
结果：
ori_obj: [1, 2, 3, 4]
new_obj: [1, 2, 3, 4]




★global全局变量
global_var_xx = 1

def func_xx():
    global global_var_xx    # 在函数中使用全局变量，否则函数内的变量会被认为是局部变量
    global_var_xx = 2
    # to do

[image: ]

区别请看以下2个示例：
示例1：使用全局变量
# -*- coding: utf8 -*-

global_var_xx = 1

def func_xx():
    global global_var_xx  # 在函数中使用全局变量，否则函数内的变量会被认为是局部变量
    global_var_xx = 2
    print(global_var_xx)

func_xx()
print(global_var_xx)
结果：
2
2

示例2：未使用全局变量
# -*- coding: utf8 -*-

global_var_xx = 1

def func_xx():
    global_var_xx = 2
    print(global_var_xx)

func_xx()
print(global_var_xx)
结果：
2
1




★Py2与Py3的区别以及让代码兼容py2与py3
#python2与python3的区别：
	区别项：
	Python2
	Python3

	发布/停更
	2000年发布，2020年停止所有维护
	2008年发布，持续维护

	定位
	仅用于维护存量系统
	新项目开发及新版本系统首选

	print打印输出
	print  "string"    #ping是一个关键字
	print("string")  #print是一个内置函数

	/整除运算
	3 / 2 = 1      #2个整数相除，结果取整
3.0 / 2 = 1.5   #有浮点数相除，结果才为float
3 // 2 = 1     #整数相除返回整数结果
3.0 // 2 = 1.0  #py2和py3相同
	3 / 2 = 1.5     #所有除法均为float
3.0 / 2 = 1.5   #所有除法均为float
3 // 2 = 1     #整数相除返回整数结果
3.0 // 2 = 1.0  #返回结果是float

	str字符串编码
	<str>  "str"实际上存储的是字节串（bytes）
<unicode> 显式指明 u"str" 才是unicode文本
	<str>  "str"存储的就是unicode文本
<bytes> 存储的是字节串，显式声明 b'xxx'

	异常捕获
	支持2种写法：
except  异常类 ,  err:    #旧式写法
except  异常类  as  err:  #新式，2.6+支持
	仅支持新式写法：
except  异常类  as  err:

	八进制数写法
	有2种写法：
num = 0755    #前缀数字0
num = 0o755   #2.6+支持，但不推荐
	仅支持一种写法：
num = 0o755

	xrange/range
	range()     #返回list（耗内存）
xrange()    #惰性生成器（省内存）
	range()    #等同于py2的xrange惰性生成器（省内存），py3没有xrange()这个函数了

	迭代器方法
	dict.keys()及dict.items() 返回的是列表
	dict.keys()及dict.items() 返回视图对象（惰性的，省内存），如果要返回列表，需要：
list(dict.keys())

	输入函数
	raw_input()   #获取输入的字符串
input()       #执行输入的代码（比较危险）
	input()    #获取输入的字符串，等同于py2的raw_input()

	编码默认值
	sys.getdefaultencoding() = 'ascii'
	sys.getdefaultencoding() = 'utf-8'

	subprocess
	py2.6无check_output()，需手动实现，
无timeout参数
	原生支持check_output() 及timeout参数
默认输出的是bytes，需要decode()转str

	datetime
	py2.7.9+才支持timestamp()时间戳，
无timezone内置类
	原生支持timestamp()时间戳，
及timezone内置类

	废弃模块
	commands, urllib2, ConfigParser 等仍可用
	废弃了commands,
重构urllib为urllib.request/ urllib.parse
ConfigParser改为小写的 configparser

	新增模块
	无核心新增模块
	新增 asyncio, enum, pathlib 等模块

	
	
	





①py2的输出语句为 print  "str" ，而在py3中使用print("str")函数
②py3的/除法为float除法，不是整除，而py2中/表示整除
③py2的源码文件默认使用ascii编码，除非指定了 # -*- coding: utf-8 -*-，py3源码文件默认使用utf8编码

若要在py2中也使用py3中的某些常用新特性，可以导入名为 __future__ 的包，导入后，py2会启导入的功能使得也支持py3的这些特性。同时py2的这些原有特性会被py3覆盖

让源代码兼容python2和python3，只需要在代码开头添加以下几行，然后都用py3的语法去写代码：
from __future__ import absolute_import
from __future__ import division
from __future__ import print_function
from __future__ import unicode_literals

import sys

if sys.version_info[0] < 3:
    reload(sys)
    sys.setdefaultencoding('utf-8')


解析：
★打印函数
导入print_function后，让python2也支持print()函数
（以下代码在py2与py3都可正常执行）
from __future__ import print_function

str_1 = "hello world"
print(str_1)


★除法
division让python2也使用py3的除法规则（浮点数运算）
（以下代码在py2与py3都可正常执行）
from __future__ import division

print('10 / 3 =', 10 / 3)
print('10.0 / 3 =', 10.0 / 3)
print('10 // 3 =', 10 // 3)
结果：
('10 / 3 =', 3.3333333333333335)
('10.0 / 3 =', 3.3333333333333335)
('10 // 3 =', 3)


★编码
python2的字符串默认使用bytes编码，字符长度同bytes字节长度
#!/usr/bin/env python
# -*- coding: utf-8 -*-

str1 = "我们"  # 默认同 b"我们"
str2 = u"我们"
print len(str1)
print len(str2)
结果：
6         # str1默认是bytes，"我们"用utf8编码时为6字节长度
2         # str2强制指定为unicode，2字符长度

让py2也默认使用py3的unicode字面量
#!/usr/bin/env python
# -*- coding: utf-8 -*-
from __future__ import unicode_literals

str1 = "我们"  # 导入unicode_literals后，默认同 u"我们"
str2 = u"我们"
print len(str1)
print len(str2)
结果：
2
2


★绝对引入
from __future__ import absolute_import
py2引入包时，直接从当前目录引入；py3默认从环境变量引入



★第4章、python推导式
推导式表示从一个数据序列构建成另一个新的数据序列，当我们使用列表推导式时，它会立即构建整个列表，并将所有元素一次性加载到内存中，对于小规模数据或轻量级操作，比较快速。但是在处理大规模数据或者列表推导式内部包含复杂操作时，列表推导式反而会降低速度，成为性能瓶颈。

① list推导式
newlist=[表达式 for 变量 in 源列表 if 条件]               #直接返回list类型
例：
names=["abc", "xdfjl", "fdklsaj"]
new_names=[name.upper()  for  name  in  names   if  len(name) >3 ]


② dictionary推导式
newdic={ key表达式: value表达式  for 变量 in 列表 if 条件}     #直接返回dictionary


③ tuple元组推导式
newtuple=(表达式 for 变量 in 列表)             #直接返回的是生成器对象，不是tuple
例：
xx=tuple( x  for  x  in  xrange(1,10) )             # tuple(推导式) 可得元组



★第5章、函数def
★定义函数
def  fun_name(参数):       #可有传入参数，也可没有
    "描述"
    语句
    return  xx             #若未指定return，则默认返回None



★参数传递
①不定长参数
def  func( *var ):            #参数以tuple形式传入，var为tuple
#或者传参数时直接传入多个值，以逗号,隔开
#若传入的变量为tuple时，不带*号则表示只有一个参数，就是tuple本身，
带*号则表示把tuple解开，变成多个参数，每个元素为一个参数


②定长参数加不定长参数
def  func( var1, var2, *var_args_tuple):
#前面2个为固定参数，后面可传入若干个可选参数，调用函数时，不可省略前面的定参


③默认参数
def  func(var1, var2=10, var3=40):
#调用时若未传入参数var2和var3，则使用默认值10，40


④解构传入tuple/dict参数
def func_test(*tuple_xx, **dict_xx):
    print(tuple_xx)
    print(dict_xx)

def func_test2(a, b, c):
    print(a, b, c)

def func_test3(name, age, weight):
    print(name, age, weight)

func_test(1, 2, 3, name="cof", age=18, weight=70)
dict1 = {'name': 'cof', 'age': 18, 'weight': 70}
func_test2(*dict1)
func_test3(**dict1)
结果：
(1, 2, 3)
{'age': 18, 'name': 'cof', 'weight': 70}
('age', 'name', 'weight')
('cof', 18, 70)                 #py2中的print输出多个值时，是以元组输出的

def func_test(*args, **kwargs):
    for arg in args:
        print(arg)
    for key, value in kwargs.items():
        print(key, value)

func_test(1, 2, 3, name="cof", age=18, weight=70)
结果：
1
2
3
('age', 18)
('name', 'cof')
('weight', 70)

说明：
*是对tuple的解构，*可对dict拿到key值(str)
**是对dict的解构，



⑤传参是否可变
不可变类型： number  string  tuple  bytes                         传递的是值
可变类型：  list  dictionary  set  bytearray  <类的实例/对象>        传递的是引用

将不可变类型参数传入函数后，函数里面对参数的修改，不会改变函数外的变量值
将可变类型参数传入函数后，函数里面对参数的修改，会改变函数外的变量值




★第6章、python2内置函数（未完成）
内置函数是指不用import导入任何模块就能直接使用的函数

①算术相关
abs(x)        #返回x的绝对值
min(x1,x2,x3)        #返回最小值

hex(x)     #将x转换成16进制数，带0x
oct(x)     #将x转换成8进制数，带0o
bin(x)     #将x转换成2进制数，带0b
int(x)      #将x转换成10进制数，默认认为x为10进制数/str，base=16指定x字符串为16进制数




★第7章、输入输出
★标准输入函数input()
内置函数input()为标准输入函数，执行到此函数时程序会暂停住，让用户从console输入，读到换行符结束，返回string，返回内容不含换行符
stdin = raw_input()
stdin = raw_input("please input: ")                #里面只可带str（字节串）类型的参数，表示提示语
stdin2 = raw_input( u"提示：".encode("utf8"))      #如果想带unicode字符串提示，得转为字节串

在linux命令行执行程序脚本时，可使用 | 管道符输入到标准输入，这时就不会暂停住了
# echo  "inputarg" |  ./test.py



★标准输入列表sys.stdin.readlines
sys.stdin有2个方法：
import  sys
sys.stdin.readline()       #读取一行，读到换行符结束，内容包含换行符，返回<str>
sys.stdin.readlines()      #读取所有行，读到Ctrl+D结束，内容包含换行符，返回<list>，每行作为一个元素<str>



★命令行输入列表sys.argv
import  sys
print  u"以下为命令行参数：", sys.argv            #sys.argv为命令行输入的参数list，第一个参数永久是程序本身（脚本名称）

在linux命令行执行程序脚本时，可直接跟在脚本后的参数称为命令行参数
# ./test.py  arg1  arg2                    #直接传入 命令行参数
# echo  "arg1" | xargs  ./test.py            # xargs将标准输入转为命令行参数



★标准输出print()
①不指定格式
print  arg1             #直接输出变量的值，不需要括号，因为py2中的print是关键字，不是函数
print  (arg1)            #输出单个字符串时，可以在变量外带上括号，print与括号之间可有空格，也可没有
print  arg1, arg2, arg3    #输出多个参数时，外面不可有括号，以逗号隔开，输出时显示时是以空格隔开的
print( arg1, arg2, arg3 )    #输出多个参数时，若外面有括号，则是以tuple形式输出的，因为括号表示tuple

print 默认是带换行的，即默认结尾符为\n，可在变量后面加上逗号，表示不额外添加换行符例如：
# -*- coding: utf8 -*-
argx = "hello"
argy = "world"
print argx,  # 输出argx内容后不换行，但会带有一个空格
print argy
结果：
hello world

②print()旧式字符串格式化
同C语言的sprintf()的格式化字符串用法，用 % 操作符
print( "这是第%2d号，体重%5.2f公折" % (num, wei) )
%-6.3f 表示左对齐，共6位宽，3位小数，浮点型（默认左对齐）
	类型码
	含义
	类型码
	含义

	%c
	字符
	%s
	字符串

	%d
	十进制整数
	%u
	无符号整数

	%o
	八进制数
	%x
	小写十六进制数

	%X
	大写十六进制数
	%f
	浮点数

	%e
	科学计数法，小写e
	%g
	自动采用最短的%f或%e

	%F
	同%f，会把inf,nan写成INF,NAN
	%E
	同%e,大写E

	%G
	同%g，会大写
	%b
	二进制数，print()不支持



# -*- coding: utf8 -*-
num = 8
wei = 59
print("这是第%2d号，体重%5.2f公折" % (num, wei))
结果：
这是第 8号，体重59.00公折



★字符串.format()格式化函数
"字符串".format(argxx) 的新式字符串格式化函数，是python 2.6开始引入的一种方法
.format()通过将strxx字符串中的{}来识别替换字段
{字段名!转换字段:格式说明}

print( "我叫{}，年龄{}岁".format("李", 20) )
print("我叫{0}，年龄{1}岁".format("李", 20))
结果：
我叫李，年龄20岁



①字段名
★可省，就写{}，默认从左到右对应后面.format()里的arg
★写数字，0，1，2 可重复用右边的字段，如0，1，1，1
★写变量名  xxx

.format()里传入tuple参数时，得带上*号，如：
cof = ("李", 20)
print("我叫{0}，年龄{1}".format( *cof) )

传入dictionary时，得带上**双星号
传入类的对象时，不带星号，在{}里取对象的属性
a = classx("李", 20)
print("我叫{0.name}，今年{0.age}".format(a))

传入list,tuple,dictionary时，若不想按顺序取值，可用.[i]按下标取值
a=[1,2,3]
print("我{0.[1]}，在{0.[0]}里".format(a))

在 Python 2.x 中，ValueError: zero length field name in format 是格式化字符串时的常见错误，核心原因是使用了空占位符（{}）但当前Python版本不支持——Python 2.6 及更早版本要求格式化占位符必须指定索引或名称，而空占位符 {} 是Python 2.7+/3.1+ 才支持的语法，py2.6及以下版本 必须指定索引或名称，如 {0}  {name}



②转换字段
!s          把参数str()一下，即调用str()去格参数
!r          repr()
!a          返回ascii()，或\unnnn  \xnnnn



③格式说明 :
前面有:冒号
顺序为      :填充 对齐方式 正负号 # 宽度 .精度 类型码

对齐方式
<           左对齐
>           右对齐
^           居中
后面必须指定宽度
print("我在{:<6}号".format( n ))

填充
在:后，对齐符前 写指定符号，如用0填充
n = 3
print("我在{:0>6}号".format(n))
结果：
我在000003号


n = 3.1
print("我在{:0>6.2f}号".format(n))  # 6位宽度，小数点后保留2位
结果：
我在003.10号

正负号
让正数带上+号
print("我在{:0>+6}号".format( n ))     #0填充默认在+号与后面数字之间了，这不是我们想要的，这时得用=指定对齐方式，默认右对齐
print("我在{:0=+6}号".format( n ))



数字形式带前缀
#b               输出带0b前缀
#o               输出带0o前缀
#x               输出带0x前缀

,数字分组分隔
让数字以3个一组带上逗号分隔符
,d                     仅对应,d，不可用,f  ,x之类
_d  _o  _x  _b        可对应这4个，以每4个字符为一组带_下划线输出

%百分比形式
{:%}          自动将数字乘以100带上%号，浮点数表示了，默认6位小数
{:.2%}        指定2位小数精度

类型码
最后是类型码，同print()旧式字符串格式化里的类型码
d            十进制整数




★optparse命令行参数识别

# -*- coding: utf8 -*-

import optparse

# 创建一个OptionParser对象
parser = optparse.OptionParser()

# 添加选项参数（optional arguments）
parser.add_option("-u", "--user", dest="user", default="default_username")
parser.add_option("-p", "--password", dest="password", default="default_password")
# 解析参数，options为选项参数，模块自动帮我们解析了，但后面的args位置参数，需要手动处理
(options, args) = parser.parse_args()
print (options.user)
print type(args)
print "args: ", args
执行示例：
# ./test.py  -u  cof  --password  passwdxxx  arg1  arg2  arg3
cof
<type 'list'>
args:  ['arg1', 'arg2', 'arg3']




★第8章、面向对象
类是由 数据结构 及对数据进行的操作方法 组成的

★类的操作
①创建类
class  类名称(object):
    """类的帮助信息，描述"""
    类的内容

class  类名称(基类1, 基类2):         #派生类
    类的内容

python2的类分2种：
经典类： 使用 class 类名:    定义，仅适用于简单场景，不推荐
新式类： 使用 class 类名(object):  定义，是py2.2+引入的类定义方式，支持所有现代面向对象特性，推荐用此方式
python3中所有的类默认继承object，无需手动写
经典类与新式类的区别：
	特性
	经典类（无继承）
	新式类（继承object类）

	继承体系
	无统一的基类，继承逻辑混乱
	所有类最终继承自object，形成统一体系

	super()支持
	不支持，只能直接调用父类方法
	支持

	多继承MRO算法
	深度优先（易出现继承顺序问题）
	C3算法，更合理的多继承顺序

	内置功能
	不支持@property、描述符等
	支持@property、__slots__、描述符等

	__class__属性
	部分场景不生效
	始终指向实例的类





②类的方法
类的方法即类里的函数，python的类方法必须有一个额外的第一个参数，类方法第一个参数名为self，表示类的实例(对象)，而非类本身
定义时有self，但在使用类方法时，不用再写这个参数！

对象：通过类定义的数据结构实例


③构造函数 __init__(self)            #init前后各2个下划线
# -*- coding: UTF-8 -*-
class MyClassA(object):
    xxx = 4  # 类变量，它的值在这个类的所有实例间共享，可在内部/外部使用它

    def __init__(self, namex, agex):  # 构造函数，初始化方法
        self.name = namex
        self.age = agex


④创建对象，对象属性
类的实例化
对象名=类名(x)                     # x参数是传给__init__()方法的

#对象可直接添加/删除/修改 属性
对象名.newAttr = value
del  对象名.xxAttr

使用函数来访问属性
getattr( obj, attrName )               #获取对象的属性
hasattr( obj, attrName )               #检查对象是否存在这个属性
setattr( obj, attrName, valuex )         #设置属性的值，若属性不存在，则创建
delattr( obj, attrName )               #删除属性


⑤内置类属性
__dict__            #类的属性，一个字典，由类的数据属性组成
__doc__             #类的文档字符串
__name__            #类名
__module__          #类定义所在的模块
__bases__           #类的所有父类，一个元组

⑥析构函数
__del__(self)         #析构方法，在对象销毁时被调用


⑦特殊属性
_protedAttr            #以单下划线开头表示protected变量，只允许其本身与子类进行访问
__privateAttr           #以双下划线开头表示private变量，只允许这个类本身访问
__privateMethod        #以双下划线开头的方法为private方法，只允许这个类本身访问

__xxx__()               #特殊方法，以双下划线开头及双下划线结尾

对象不可访问类的私有变量（以双下划线开头），但可用以下形式来访问：
对象名._类名__私有属性名
# -*- coding: UTF-8 -*-

class MyClassA(object):
    def __init__(self, length):  # 构造函数，初始化方法
        self.length = length
        self.__name = "cof"
        print(self.__name)

obj = MyClassA(3)
print(obj.__name)
结果：
[image: ]

换成以下方式，则可成功读取到对象的私有属性：
# -*- coding: UTF-8 -*-

class MyClassA(object):
    def __init__(self, length):  # 构造函数，初始化方法
        self.length = length
        self.__name = "cof"
        print(self.__name)


obj = MyClassA(3)
print "对象的私有属性值为", obj._MyClassA__name
结果：
cof
对象的私有属性值为 cof


★__sttr__()与__repr__()
__str__()和__repr__()方法都用于定义对象的字符串表示，但__str__()更适合用于友好的打印输出，而__repr__()更适合用于精确重现对象。如果两者都被定义，通常情况下__str__()方法会被print()函数等显示函数使用，而__repr__()方法会被交互式解释器使用。
# -*- coding: UTF-8 -*-

class MyClass(object):
    def __init__(self, var="default"):
        self.var = var

    def __str__(self):
        return "This is MyClass"

    def __repr__(self):
        return "MyClass()"


obj = MyClass()
print(obj)  # 输出: This is MyClass （有定义__str__()时，优先输出此函数的返回值，否则次优先输出__repr__()，2者都没有定义，则输出对象地址（系统默认格式））
print(obj.__str__())  # 输出: This is MyClass
print(obj.__repr__())  # 输出: MyClass()
结果：
This is MyClass
This is MyClass
MyClass()


# -*- coding: UTF-8 -*-

class MyClass(object):
    def __init__(self, var="default"):
        self.var = var


obj = MyClass()
print(obj)  # 输出: 有定义__str__()时，优先输出此函数的返回值，否则次优先输出__repr__()，2者都没有定义，则输出对象地址（系统默认格式）
print(obj.__str__())  # 输出: This is MyClass
print(obj.__repr__())  # 输出: MyClass()
结果：
<__main__.MyClass object at 0x000002646EC9F1F0>
<__main__.MyClass object at 0x000002646EC9F1F0>
<__main__.MyClass object at 0x000002646EC9F1F0>


★_len__()  对象的长度
# -*- coding: UTF-8 -*-

class MyClassA(object):
    def __init__(self, length):  # 构造函数，初始化方法
        self.length = length

    def __len__(self):
        return int(self.length)

obj = MyClassA(3)
print(len(obj))
结果：
3




★静态方法
不需要生成类的实例（对象），就可访问其定义的函数（方法），这种方法称为静态方法
Python 从2.2开始，支持@staticmethod 装饰器，2.6、2.7 等主流版本完全支持 @staticmethod 装饰器定义静态方法，同时也支持 @classmethod 装饰器（类方法）

# -*- coding: UTF-8 -*-

class MyClass(object):
    version = "1.0"

    def __init__(self, age):  # 构造函数，初始化方法
        self.age = age
        print("my age is {0}".format(self.age))

    @staticmethod
    def func_xx(name):  # 在方法的上方添加 @staticmethod 表示此方法为静态方法，静态方法没有self参数
        print("my name is {0}".format(name))
        print("staticmethod: {0}".format(MyClass.version))  # 如果要访问类本身的属性，需要指定类名

    @classmethod
    def func_yy(cls):
        # 接收cls参数（代表类本身），可灵活访问、修改类属性
        print("classmethod：{0}".format(cls.version))


MyClass.func_xx("cof")  # 直接使用类的静态方法
MyClass.func_yy()
结果：
my name is cof
staticmethod: 1.0
classmethod：1.0




★with上下文管理器
with语句是一种用于简化资源获取和释放的语法结构，它可以确保在代码块执行完毕后，自动清理和释放相应资源（如文件、网络连接、数据库连接等）这种特性被称为“上下文管理器”

Python 2.6+（包括 RHEL 6 的 2.6.6）完全原生支持 with上下文管理器，2.5需导入未来特性，2.4及以下不支持。with是Python 2 中简化资源管理的核心语法，用法与Python3高度兼容，优先用于文件、锁等需要自动收尾的场景


with语句的基本语法如下：
with context_manager as variable:
    # 执行代码块
    # context_manager是一个上下文管理器，它通常是一个实现了__enter__() 和__exit__()方法的对象
    # variable是一个可选的变量，用于接收context_manager的__enter__()方法返回值


在文件操作中，with语句非常常见，它可以确保文件在使用后被自动关闭，例如：
with open('test.txt', 'r') as file:
    content = file.read()
    print(content)  #无需要手动关闭文件

★自定义上下文管理器
创建一个类，然后通过定义__enter__()和__exit__()方法来管理资源，例如：
# -*- coding: UTF-8 -*-

class MyResource(object):
    def __init__(self, name):
        self.name = name

    def __enter__(self):
        print("MyResource.__enter__: Entering...")
        return self

    def __exit__(self, exc_type, exc_value, traceback):
        print("MyResource.__exit__: Exiting...")
        # 这里可以处理资源释放，如关闭文件，关闭网络连接等
        # 如果有异常发生，可以通过返回False来传播异常
        return False


with MyResource("hellow") as resource:
    print(resource.name)  # 对resource对象处理完成后，不需要手动关闭它，会自动调用__exit__()方法
结果：
MyResource.__enter__: Entering...
hellow
MyResource.__exit__: Exiting...





★其他方法

#让类也能当函数使用
# -*- coding: utf8 -*-

class MyCalss(object):
    def __init__(self, value):
        self.value = value

    def __call__(self, new_value):  # 类也能当函数使用
        self.value = new_value
        print("new_value is {}".format(self.value))


a = MyCalss("1111")
a("2222")
结果：
new_value is 2222




★第9章、异常处理
异常是python对象，表示一个错误，当程序发生异常时，需要捕获处理它，否则程序会终止执行。
python中的各种异常类都继承自BaseException这个基类。
BaseException派生出了4个之类：
用户中断执行时异常（keyboardinterrupt）
python解释器退出异常（systemexit）
内置及非系统退出异常（exception）  # 遇到最多的就是exception类异常
生成器退出异常（generatorexit）

常见的基于Exception类的异常：
	NameError
	属于编译时异常，产生原因：使用了未定义的变量

	IndexError
	属于运行时异常，产生原因：列表/元组等访问越界，索引越界

	AttributeError
	属于运行时异常，产生原因：访问某个对象的不存在的属性

	FileNotFoundError
	属于运行时异常，产生原因：打开文件时，目标文件不存在

	ZeroDivisionError
	属于运行时异常，产生原因：算术运算时，除数为0了

	AssertionError
	属于运行时异常，产生原因：由 assert 语句抛出的




①捕获异常可用try, except语句
try:
    #要执行的语句
except xx异常类:            #可以不匹配具体的错误类
    #要执行的语句
except yy异常类 , 数据:       #python2.6及以上版本 也支持 except  异常类  as  err:  这种写法
    #要执行的语句
else:
    #如果没有异常发生时 执行的语句
finally:
    #不管有无异常最终都要执行的语句

②触发异常
可以使用raise语句 自己 触发异常
def myFunc(varx):
    if varx < 10:
        raise Exception("提示信息", varx)
        # 触发异常后，后面的代码不会再执行

# 使用
try:
    myFunc(n)
except Exception, err:      #python2.6及以上版本 也支持 except  异常类  as  err:  这种写法
    # 要执行的语句，err就是抛出的varx

自定义异常类，创建一个新类，继承自Exception类
class MyError(Exception):            #创建自定义类，继承自Exception
    def __init__(self, arg):
        self.arg = arg
        # 其他语句

# 捕获异常
try:
    raise MyError("xx")          # 抛出异常
except MyError, err:        #python2.6及以上版本 也支持 except  异常类  as  err:  这种写法
    # to do


★使用assert语句抛出异常
assert语句又称为断言语句，格式为如下：
assert 表达式
assert 表达式, "异常信息"
表达式的结果为False时，触发AssertionError异常；值为True时，不做任何操作。
示例：
def func_xx(num1, num2):
    assert num2 != 0, "func_xx: 分母不能为0"  #当assert后面的表达式返回True时，才继续往下执行
    return num1 / num2

try:
    func_xx(3, 0)
except AssertionError, err:   #python2.6及以上版本 也支持 except  异常类  as  err:  这种写法
    print(err)
结果：
func_xx: 分母不能为0




★第10章、文件操作
使用内置函数open()打开一个文件，返回file对象，再调用此对象的相关方法进行读写操作

★文件打开模式
	模式
	文本
	二进制
	指针位置
	是否覆盖
	含义

	只读
	r
	rb
	开头
	否
	只读；若文件不存在则报错

	只写
	w
	wb
	开头
	是
	全覆盖；打开文件时清空文件；不存在则新建

	只写
	a
	ab
	末尾
	否
	追加；不存在则新建

	读写
	w+
	wb+
	开头
	是
	读写，打开文件时就清空文件；若文件不存在则创建新的文件

	读写
	r+
	rb+
	开头
	否
	读写，写时从头插入，不覆盖；若文件不存在则报错

	读写
	a+
	ab+
	末尾
	否
	读写，写时追加；若文件不存在则新建



例：
fileobj = open("test.txt", "r")
fileobj.close()                      # 关闭文件


★处理打开文件时的异常
try:
    fileobj = open("test.txt", "r")
    # to do
    fileobj.close()
except Exception as err:
    print(err)

也可直接使用with去打开文件，就不用手动关闭文件了
with open('test.txt', 'r') as fileobj:
    # to do




★文本文件读写操作（open方法）不推荐
python2不建议使用open方法进行文本文件的读写，没法指定字符编码

.write()方法写入文件，打开文件默认是跟随系统本地语言编码，写入文件也是，得在打开文件时指定文本编码；写入内容时，默认末尾不带换行符，可自己加\n
# -*- coding: utf8 -*-

with open("test.txt", "w+") as fileobj:  # 默认使用的字符集跟随系统，若开头指定了coding: utf8，则使用utf8
    fileobj.write("默认是不换行的")
    fileobj.write("，支持使用转义加n去换行\n这是第二行")
效果：
[image: ]

.flush() 方法刷新文件内部缓冲，把内部缓冲区的数据立刻写入文件

.read(n) 读方法，一次读n个字节，如果不是ascii编码，则不建议使用此种方法
with open("test.txt", "r+") as fileobj:
    stx = fileobj.read(10)  # 读取10个字节
    print(stx)

.readline() 一次读一行，返回的字符串是带有换行符的
# -*- coding: utf8 -*-

with open("test.txt", "r+") as fileobj:
    stx = fileobj.readline()
    print(stx.decode("utf8"))
.readlines() 读取所有行，返回的是由每一行组成的list（带有换行符）





★文本文件读写操作（codecs.open方法）
python2不建议使用open方法进行文本文件的读写，没法指定字符编码，建议使用codecs.open()
# -*- coding: utf8 -*-

import codecs

lines = [u"这是一行\n", u"另一行\n"]
with codecs.open("test.txt",  # 要打开的目标文件路径
                 mode="w+",  # 打开模式
                 encoding="utf8",  # 指定文件编码
                 errors="strict",  # 编码错误处理：strict, ignore, replace等
                 buffering=1  # 缓冲：1：行缓冲，0：无缓冲，大于1表示字节缓冲
                 ) as fh:
    fh.write(u"大家好\n")  # 写入字符串，要显式指定为unicode字符串
    fh.writelines(lines)  # 写入多行，字符串list

with codecs.open("test.txt", mode="r", encoding="utf8") as fh:
    content = fh.read()  # 读取整个文件所有内容，返回的是unicode字节串
    print(content)

print "--------------------"
with codecs.open("test.txt", mode="r", encoding="utf8") as fh:
    str_xx = fh.read(5)  # 读取5个字符（unicode字符），返回的是unicode字节串，换行算一个字符
    print(str_xx)

print "--------------------"
with codecs.open("test.txt", mode="r", encoding="utf8") as fh:
    for line in fh:  # 按行读取，返回的是unicode字节串
        print(line)

支持的常用字符集编码：
	utf-8
	Unicdoe，默认无BOM

	utf-16
	Unicdoe，默认小端字节序，有BOM，支持UTF16代理对

	gbk
	中文-大陆，默认无BOM

	euc-jp
	日语

	shift-jis
	日语

	euc-kr
	韩语

	big5
	中文-台湾

	latin-1
	iso-8859-1





★二进制文件操作→struct模块
在打开文件时，操作符添加b就行，读写仍然使用.read()和.write()方法，读取的二进制内容是存储在bytes里，可以使用struct模块去解析成对应的数据类型

★打开文本文件与打开二进制文件的区别：
打开文本文件时：遇到EOF(0x1A)则认为文件结束了，不管文件里是\r\n还是\n换行，读取到string里只有\n，写入时也会转换\n为相应的系统换行符
fp.read()返回的是string类型

打开二进制文件则会读取到文件结尾，不转换\r\n等字符，且不可指定encoding="编码"
fp.read()返回的是bytes类型

struct模块中最重要的三个函数是pack(), unpack(), calcsize()
struct.pack('fmt', v1, v2, ...)          #按照给定的格式(fmt)，把数据封装成bytes(实际上是类似于c结构体的字节流)
struct.unpack('fmt', bytesxx)         #按照给定的格式(fmt)解析bytes，返回解析后的tuple
struct.calcsize('fmt')                #计算给定的格式(fmt)占用多少字节的内存

struct中支持的格式
	format
	对应的C类型
	python类型
	字节数

	c
	char
	string of length 1
	1

	s
	char[]
	string
	1

	b
	signed char
	int
	1

	B
	unsigned char
	int
	1

	h
	short
	int
	2

	H
	unsigned short
	int
	2

	i     l
	int     long
	int
	4

	I     L
	unsiged int/long
	int
	4

	q
	long long
	long int
	8

	Q
	unsigned long long
	long int
	8

	f
	float
	float
	4

	d
	double
	float
	8

	?
	_Bool
	bool
	1




format指定原始数据的字节序：
字节序默认跟随系统，x86_64为小端字节序
	符号
	byte order
	字节对齐方式

	@
	native
	凑够4个字节

	=
	native
	按原字节数

	<
	little-endian
	按原字节数，小端字节序

	>
	big-endian
	按原字节数，大端字节序，逻辑上是啥顺序就是啥

	!
	network = big-endian
	按原字节数，网络字节序


使用方法是在format的第一个位置指示即可
struct解析二进制串示例：
import struct
with open("test.txt","rb+") as fileobj:
    strb=fileobj.read(10)
    a,b,c=struct.unpack("<2ih",strb)
    print(a,b,c)
<2ih  表示使用小端字节序，2个int赋值给a和b两个变量，1个short赋值给c

import struct
with open("test.txt","rb+") as fileobj:
    strb=fileobj.read(10)
    a,b,c=struct.unpack("<ih4s",strb)
<ih4s  表示小端字节序，一个i赋值给a，一个h赋值给b，4s表示4字节的string赋值给c

★struct.unpack()返回的是tuple，如果只有一个元素，则左边要写a,=struct.unpack()，带有个逗号，否则a就是tuple的类型了


struct将数据转换成二进制串示例
a = 5
b = 89.4
strb = struct.pack("if", a, b)
print(len(strb))     #结果是8

★python3在将str="xxx"转换成3s时，会报错：
struct.error: argument for 's' must be a bytes object

需要在传入的字符参数前加b
import struct
a=b'hello'
b=b'world!'
bytes=struct.pack('5s6s',a,b)
或者把str转为对应编码的bytes
strxx.encode("utf8")

★struct.pack()返回的是python2的str（字节串）类型，不可变量



★第11章、模块，包
包是一个分层次的文件目录结构，它定义了一个由模块及子包组成的python应用环境
包是一种管理python模块命名空间的形式
包是一个文件夹，包文件夹下必须存在__init__.py文件，该文件可以为空

__init__.py文件用于标识当前文件夹是一个包，包下的其他*.py文件为模块定义文件
如果要让其他程序导入此包下的所有模块，需要在__init__.py里使用__all__变量导出相应的模块，__init__.py文件内容如下：（示例中的cof，lee为2个模块名称，即对应包下的cof.py及lee.py这2个模块文件）
__all__ = ["cof",
           "lee"]


★导入模块
import 包名1.子包名.模块名
# 使用模块里的变量/函数时得使用完整名称
包名1.子包名.模块名.funxx()

from 包名1.子包名 import 模块名x
# 这时可直接使用 模块加变量/函数的方式
模块名x.funxx()

from .模块名x
# .相对路径导入，表示 模块名x 在本模块同目录下， ..2个点表示在父目录下的
模块名x.funxx()

from 包名x import *
#这时，只会导入 包名x 下的__init__.py里的 __all__=[这里列出的函数及变量]

一个模块被另一程序第一次导入时，其主程序将运行，若不想让它运行，可做个判断：
if __name__=="__main__":
    #被导入模块的主程序写这里，只有它自己执行时才运行这里的代码，只有直接执行此模块脚本时才会运行这里的代码
else:
    #来自另一程序的调用，当其他脚本import此模块时，此模块的名称就是此模块的脚本文件名（不含.py）后缀

import sys as xx             #将导入的模块名 sys 设置别名为 xx ，下文即可使用xx.func()
print(xx.path)

示例：
我们在test_module.py文件里写如下代码：
#!/usr/bin/env python
# -*- coding: UTF-8 -*-

if __name__ == "__main__":
    print("直接执行了此脚本，__name__为 {}".format(__name__))
else:
    print("import了此脚本，__name__为 {}".format(__name__))
然后在另一脚本test.py里import引入此模块：
import test_module

print("hellow")
运行test.py的结果：
import了此脚本，__name__为 test_module
hellow



★一个模块被导入时，解释器默认会将它编译成可执行的字节码.pyc
在模块所处包下生成一个名为__pycache__的目录，里面就是各模块的字节码文件
linux下可设置环境变量不生成字节码文件：
export  PYTHONDONTWRITEBYTECODE=1
import sys
sys.dont_write_bytecode = True          #指定在导入时不生成字节码



★python解释器查找模块顺序
python解释器会去哪里找要导入的模块呢？
1，首先查找sys.modules字典里的模块（这是以前导入的所有模块的缓存）
2，然后匹配内置的模块sys.builtin_module_names
3，最后根据sys.path路径下去找（包含有程序当前路径；pip安装的包在"site-packages"目录下）

都找不到就报错ModuleNotFoundError
# python2 -c "import sys; print sys.path"
['',        #同程序当前路径
'/usr/lib64/python27.zip', 
'/usr/lib64/python2.7', 
'/usr/lib64/python2.7/plat-linux2', 
'/usr/lib64/python2.7/lib-tk', 
'/usr/lib64/python2.7/lib-old', 
'/usr/lib64/python2.7/lib-dynload', 
'/usr/lib64/python2.7/site-packages', 
'/usr/lib/python2.7/site-packages']

# python2 -c "import sys; print sys.path"
['',        #同程序当前路径
'/usr/lib64/python26.zip',
'/usr/lib64/python2.6',
'/usr/lib64/python2.6/plat-linux2',
'/usr/lib64/python2.6/lib-tk',
'/usr/lib64/python2.6/lib-old',
'/usr/lib64/python2.6/lib-dynload',
'/usr/lib64/python2.6/site-packages',
'/usr/lib/python2.6/site-packages']


★判断当前环境是否有某个模块：
如果import的模块找不到，就报ModuleNotFoundError异常
try:
    import 模块名
except Exception as e:
    print(e)
如果没有指定的模块，则结果如下：
[image: ]




★第12章、pip操作
pip是一个Python包安装与管理工具
Python 2.x默认不带有pip命令
Python 3.5及以上版本都自带pip命令

★pip操作命令
pip安装的包默认在 site-packages子目录下

# pip  freeze                                       #查看用pip安装的包
# pip  list                                          #查看所有pip包
# pip  list  -o                                       #同 --outdated 查看所有包及可更新的版本
#pip  install  包名                                  #安装包
#pip  install  包名==x.x.x                             #安装包时指定相应版本号
#pip  install  -r  requireMents.txt                      #一次安装此txt文件里的所有包，一行一个软件包
#pip  install  -U  包名                               #更新包，同--upgrade

#python  -m  pip  install  --upgrade  pip              #升级pip本身的版本
#pip  download  -d  /下载目录  包名                 #只下载包（依赖也一并下载），不安装

# pip  install   xxxx  --proxy="http://x.x.x.x:3128"        #使用代理
# pip  install   xxxx.whl                              #安装本地whl包
# pip  uninstall   包名                               #卸载依赖包

#pip默认从以下地址下载软件包：
https://pypi.org/simple                                #可以指定成其他的pip源地址


①-i指定软件源
#pip  install  包名  -i  https://xxx.com/simple  --trusted-host  xxx.com


②写入配置文件
在当前用户家目录下创建.pip目录，其下创建pip.conf文件
（windows为家目录下的pip目录下创建pip.ini文件）
# mkdir  ~/.pip
# vi  ~/.pip/pip.conf
[global]
index-url=https://xxx.com/simple
trusted-host=xxx.com
proxy=http://x.x.x.x:3128
[install]
trusted-host=xxx.com


★国内的pip源地址：
http://mirrors.aliyun.com/pypi/simple
https://pypi.tuna.tsinghua.edu.cn/simple



★python2.7安装pip命令
# curl  https://bootstrap.pypa.io/pip/2.7/get-pip.py  -o  get-pip.py
# python2  get-pip.py
Installing collected packages: pip, setuptools, wheel
Successfully installed pip-20.3.4 setuptools-44.1.1 wheel-0.37.1

# pip2  list
DEPRECATION: Python 2.7 reached the end of its life on January 1st, 2020. Please upgrade your Python as Python 2.7 is no longer maintained. pip 21.0 will drop support for Python 2.7 in January 2021. More details about Python 2 support in pip can be found at https://pip.pypa.io/en/latest/development/release-process/#python-2-support pip 21.0 will remove support for this functionality.

#或者手动下载软件包并解压到以下路径：
/usr/lib/python2.7/site-packages




★python创建虚拟环境
有时在同一台服务器上安装多个python包，可能会产生依赖冲突问题，可以通过创建虚拟环境来解决，python虚拟环境的原理是创建一个目录，在此目录下创建一个python软件链接，并激活一个shell环境变量，让系统优先从此虚拟环境的目录下去查找/安装依赖包


★python2创建虚拟环境
#首先安装pip2，再用pip2安装virtualenv软件包
# pip2  install  virtualenv
# mkdir  -p  ~/xxx-venv
# virtualenv  -p  python2  ~/xxx-venv               #创建虚拟环境
# source  ~/xxx-venv/bin/activate                    #激活指定的虚拟环境

# deactivate                                      #退出当前虚拟环境




★pycharm安装模块
File → Settings → Project: xxx →Python Interpreter → 右侧选择目标python解释器，再点击下面的+加号
[bookmark: _GoBack][image: ]




★第13章、anaconda
conda是代码包及其依赖项和环境的管理工具，conda为Python项目而创造，但可适用于以下多种语言：
Python, R, Ruby, Lua, Scala, Java, JavaScript, C/C++, FORTRAN

anaconda是一个包含180+的科学包及其依赖项的发行版本，其包含的科学包包括：conda, numpy, scipy, ipython notebook等

conda包和环境管理器包含于Anaconda的所有版本当中

	pip
	是用于安装和管理软件包的 包管理器，维护多个环境难度较大

	virtualenv
	是用于创建一个独立的Python环境 的工具
不同的py程序需要不同的python版本及不同版本的依赖包，在共享主机时，无法在全局site-packages目录中安装依赖包。
virtualenv将会为它自己的安装目录创建一个环境，这并不与其他virtualenv环境共享库；同时也可以选择性地不连接已安装的全局库。

	conda
	结合了pip和virtualenv的功能，比较方便地在不同环境之间进行切换，环境管理较为简单

	
	




★centos安装anaconda3
anaconda下载地址： https://www.anaconda.com/products/distribution
不区分linux版本，一般centos7，centos8，ubuntu2004，2204等版本都可以直接安装
# bash  Anaconda3-2022.10-Linux-x86_64.sh
[image: ]
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一直按空格翻页，直到出现下面提示： Do you accept the license terms? [yes|no]
[image: ]
输入yes
[image: ]
默认是安装在/root/anaconda3目录下，如果不是root用户，请输入当前用户能访问的目录

# bash  Anaconda3-2022.10-Linux-x86_64.sh  -p  /opt/anaconda3
#这样可跳过软件安装路径确认阶段，直接安装到指定目录下
然后等待安装完成
[image: ]

[image: ]
#是否初始化conda的环境，直接输入yes，回车
[image: ]
conda命令在安装目录的bin子目录下，默认把初始命令添加到~/.bashrc文件里，由于我们没有重新登录系统，所以它没有重新加载bash配置，需要手动执行一下：
# source  ~/.bashrc             #之后就可以正常使用conda命令了

# >>> conda initialize >>>
# !! Contents within this block are managed by 'conda init' !!
__conda_setup="$('/root/anaconda3/bin/conda' 'shell.bash' 'hook' 2> /dev/null)"
if [ $? -eq 0 ]; then
    eval "$__conda_setup"
else
    if [ -f "/root/anaconda3/etc/profile.d/conda.sh" ]; then
        . "/root/anaconda3/etc/profile.d/conda.sh"
    else
        export PATH="/root/anaconda3/bin:$PATH"
    fi
fi
unset __conda_setup
# <<< conda initialize <<<


# conda  info                    #查看conda信息
[image: ]



★普通用户使用conda
前提是安装anaconda时，安装在普通用户能访问的目录下，比如/opt/anaconda3
普通用户登陆后，需要执行一下 conda  init 使conda的路径等系统环境变量信息写入当前用户的bashrc下
# /opt/anaconda3/bin/conda  init  bash       #需要根据自己的实际情况修改bin之前的目录
# source  ~/.bashrc                         #普通用户就可正常使用了




★第14章、python常用模块
★decimal精确计算模块
import decimal
nn=decimal.Decimal(3.141592653589793)
nn/=decimal.Decimal(2.2)
print(nn)

Decimal数只能和Decimal数进行算术操作
import decimal
print(decimal.getcontext())           #获取上下文，查看精度等默认参数，默认prec=28
decimal.getcontext().prec=60           #设置为60位精度



★struct二进制数据处理模块
请见第10章的“二进制文件操作→struct模块”




★time时间日期模块
时间是以秒为单位的浮点小数
时间戳表示从1970年1月1日0时到现在经过的秒数，传统4字节表示秒数只支持1970到2038年的时间

①获取时间戳 time.time()
# -*- coding: UTF-8 -*-

import time
print("当前时间戳: {}".format(time.time()))
print(type(time.time()))
结果：
当前时间戳: 1765278604.94
<type 'float'>


②时间结构体，有9个字段
import time

localtime = time.localtime(time.time())
print(localtime)
print(type(localtime))
结果：
time.struct_time(tm_year=2025, tm_mon=12, tm_mday=9, tm_hour=19, tm_min=10, tm_sec=58, tm_wday=1, tm_yday=343, tm_isdst=0)
<type 'time.struct_time'>


③格式化时间
import time
print(time.strftime("%Y-%m-%d %H:%M:%S",time.localtime()))
print(time.strftime("%a %b %d %H:%M:%S %Y",time.localtime()))        # %a表示周几
print(time.strftime("%a, %d %b %Y %H:%M:%S %z",time.localtime()))
结果：
2024-11-24 12:17:05
Sun Nov 24 12:17:05 2024               #日期不足2位不以0填充
Sun, 24 Nov 2024 12:17:05 +0800

import time
print(time.ctime(time.time()))
print(time.asctime(time.localtime()))             #同 time.ctime()
结果：
Tue Dec 09 19:16:22 2025
Tue Dec 09 19:16:22 2025            #日期不足2位不以0填充


④时间字符串转为时间结构体
import time
timestr="Tue Apr 05 22:22:15 2022"
t=time.strptime(timestr,"%a %b %d %H:%M:%S %Y")
print(t)
print(type(t))
结果：
time.struct_time(tm_year=2022, tm_mon=4, tm_mday=5, tm_hour=22, tm_min=22, tm_sec=15, tm_wday=1, tm_yday=95, tm_isdst=-1)
<type 'time.struct_time'>

⑤时间结构体转为时间戳
import time
timestr="Tue Apr 05 22:22:15 2022"
t=time.strptime(timestr,"%a %b %d %H:%M:%S %Y")
tstamp=time.mktime(t)             #时间结构体转为时间戳
print(tstamp)                       #结果 1649168535.0


⑥暂停线程的运行
import time
time.sleep(5)                      #单位为 秒




★datetime时间日期模块

#!/usr/bin/env python
# -*- coding: utf8 -*-
import time
import datetime

# 注意，datetime是模块，datetime模块有一个名为datetime的类
print(datetime.datetime.now())  # 返回当前日期及时间<datetime>（本地时间）如 2024-05-29 15:44:30.203461
dt = datetime.datetime(2024, 5, 29, 15, 46, 0)  # 构建一个<datatime>对象，2024-05-29 15:47:32.460047
timestamp = time.mktime(dt.timetuple())
print("timestamp: {}".format(timestamp))
ts = 1716968760.0
print(datetime.datetime.fromtimestamp(ts))  # 根据时间戳构建<datetime>
time_str = "2024-05-29 15:52:00"
print(datetime.datetime.strptime(time_str, "%Y-%m-%d %H:%M:%S"))  # 根据时间字符串构建<datetime>
dt_utcnow = datetime.datetime.utcnow()  # 当前utc时间
print("utcnow: {}".format(dt_utcnow.strftime("%Y-%m-%d %H:%M:%S")))  # 把时间对象<datetime>转为时间字符串
dt_local_now = datetime.datetime.now()  # 当前本地时间
print("local_now: {}".format(dt_local_now.strftime("%Y-%m-%d %H:%M:%S")))  # 把时间对象<datetime>转为时间字符串
new_date = dt_local_now + datetime.timedelta(days=2, hours=3)  # 当前时间加上2天3小时后，得到新的时间
print(new_date)



★sys模块（py解释器相关）
#!/usr/bin/env python
# -*- coding: utf8 -*-
import sys

print(sys.argv)  # sys.argv为标准输入参数列表，第0个元素为程序名本身

print(sys.getdefaultencoding())  # 查看python默认字符编码
print(sys.version_info)  # 返回python版本信息，可用sys.version_info[0],[1],[2]获取相应版本号
# sys.version_info(major=2, minor=7, micro=5, releaselevel='final', serial=0)
# (2, 6, 6, 'final', 0)
print(sys.platform)  # win32, linux2
print(sys.getwindowsversion())  # (major=6, minor=2, build=9200, platform=2, service_pack='')
my_module_path = '/path/to/project'
sys.path.append(my_module_path)  # 将项目目录添加到python模块搜索路径中（搜索列表的末尾）
sys.path.insert(0, my_module_path)  # 将项目目录添加到python模块搜索路径中（搜索列表的第0个元素）





★os操作系统接口模块

#目录文件操作
# -*- coding: utf8 -*-

import os

cdir = os.getcwd()  # 返回当前工作目录str
os.chdir("D:\\")  # 切换当前目录
dir1 = "D:\\tmp_dir2\\xxx"
if os.path.exists(dir1):
    print(u"目录 {0} 已存在".format(dir1))
else:
    os.makedirs(dir1, mode=0755)  # 创建目录（若目录已存在会报错）

ret = os.system("dir")      # 执行系统命令，成功执行返回0，失败返回非0数值，输出结果直接在命令行打印出来

import os

current_dir = os.getcwd()
path1 = os.path.join(current_dir, "child_dir", "file.txt")  # 路径拼接
print("拼接路径: {}".format(path1))
结果：
拼接路径: D:\myPython2\test_any\child_dir\file.txt

# -*- coding: UTF-8 -*-
import os

file_name = '/opt/path/to/soft/test.py'  # 此文件可以不真实存在
print os.path.dirname(file_name)  # 提取文件或路径 的父目录（最后一级是文件时，返回其所在目录，最后一级是目录时，返回其上一级目录）
print os.path.split(file_name)  # 拆分路径为（目录，文件）
file2_name = 'test2.file'
print os.getcwd()  # 获取当前工作路径
print os.path.abspath(file2_name)  # 返回文件的绝对路径（此文件不一定存在），其实就是将当前工作路径拼在此文件前面
结果：
/opt/path/to/soft
('/opt/path/to/soft', 'test.py')
D:\pythonProjects\python2_test\pythonProject
D:\pythonProjects\python2_test\pythonProject\test2.file


批量重命名文件：
#!/usr/bin/env python
# -*- coding: UTF-8 -*-
import os

file_dir = 'D:\\test'
file_name_list = os.listdir(file_dir)
for file_name in file_name_list:
    old_file_full_name = os.path.join(file_dir, file_name)
    if os.path.isfile(old_file_full_name):  # 是普通文件才重命名
        print(u"{0} 是一个普通文件".format(file_name))
        new_file_full_name = os.path.join(file_dir, "new-" + file_name)
        os.rename(old_file_full_name, new_file_full_name)  # 重命名文件
    if os.path.isdir(old_file_full_name):  # 是目录 则不会重命名
        print(u"{0} 是一个目录".format(old_file_full_name.decode("gbk")))
结果：
test1.txt 是一个普通文件
test2.txt 是一个普通文件
D:\test\新建文件夹 是一个目录
[image: ]

# -*- coding: UTF-8 -*-
import os

def get_self_dir(path):  # 获取目录本身
    abs_path = os.path.abspath(path)  # 先获取绝对路径
    if os.path.isdir(abs_path):  # 判断此绝对路径是否为一个目录
        return abs_path  # 是，则返回目录本身
    return os.path.dirname(abs_path)  # 否则（表示此绝对路径为一个文件），返回其父目录

print get_self_dir("/var/log")
print get_self_dir("/var/log/messages")
结果：
/var/log
/var/log



#环境变量操作
# -*- coding: utf8 -*-
import os

env = os.environ  # 获取系统的环境变量
print(type(env))  # 是一个可迭代的key-value对象
for key, value in env.items():
    print("{0} --> {1}".format(key, value))
结果：
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#获取当前程序的pid
# -*- coding: UTF-8 -*-
import os

my_pid = os.getpid()
print("my pid is: {0}".format(my_pid))
结果：
my pid is: 11652




★subprocess模块
用于在目标系统上创建子进程执行命令，并返回状态码及标准输出/标准错误的内容
os.system("cmd")只能返回状态码，无法保存执行命令的结果到某个返回参数，而使用subprocess.run()就可以获得执行结果内容

subprocess 模块是替代 os.system()、os.popen() 等老旧接口的核心子进程管理工具，用于创建、控制和与子进程交互（执行系统命令 / 外部程序）

#Windows使用示例：
# -*- coding: utf8 -*-
import subprocess

cmd = "ping -n 3 10.99.1.1"
env = {"PATH": "C:\\Windows\\System32"}
process = subprocess.Popen(
    cmd,
    shell=True,
    # env=env,
    stdout=subprocess.PIPE,
    stderr=subprocess.PIPE
)
stdout, stderr = process.communicate()
return_code = process.returncode
if return_code != 0:
    print(u"return not 0, stderr: {}, stdout: {}".format(stderr.decode("gbk"), stdout.decode("gbk")))
else:
    print(u"return 0, stderr: {}, stdout: {}".format(stderr.decode("gbk"), stdout.decode("gbk")))
结果：
[image: ]

#Linux使用示例：
# -*- coding: utf8 -*-
import subprocess

cmd = "ping -c 3 10.99.1.1"
env = {"PATH": "/usr/bin:/bin:/usr/sbin:/sbin"}
cwd = "/root"
process = subprocess.Popen(
    cmd,  # 要执行的命令
    shell=True,  # True表示通过shell执行，支持管道/通配符
    env=env,  # 子进程环境变量（默认继承主进程）
    cwd=cwd,  # 子进程工作目录（默认继承主进程）
    stdout=subprocess.PIPE,
    stderr=subprocess.PIPE
)
stdout, stderr = process.communicate()  # communicate()会等待子进程结束，若子进程输出过多且未重定向，可能会导致死锁
# 返回的内容是str字节串，非ascii字符需要手动解码
return_code = process.returncode
if return_code != 0:
    print(u"return not 0, stderr: {0}, stdout: {1}".format(stderr.decode("utf8"), stdout.decode("utf8")))
else:
    print(u"return 0, stderr: {0}, stdout: {1}".format(stderr.decode("utf8"), stdout.decode("utf8")))
结果：
[image: ]

命令参数格式：
shell=False 时，cmd 需为列表（如 ["ls", "-l"]），避免安全问题（如命令注入）；
shell=True 时，cmd 可为字符串（如 "ls -l"），但需注意安全风险


#执行命令超时控制
# -*- coding: UTF-8 -*-
import subprocess
import threading

def run_command_with_timeout(cmd, timeout=5, shell=False):
    """
    执行命令并控制超时
    :param cmd: 命令（字符串/列表，shell=False时用列表）
    :param timeout: 超时时间（秒）
    :param shell: 是否用shell执行
    :return: 子进程输出（stdout）、退出码
    :raises:  Exception 异常
    """
    # 存储子进程的执行结果
    result = {
        "stdout": "",
        "stderr": "",
        "returncode": 0,
        "timeout": False
    }
    # 创建子进程（捕获stdout/stderr）
    p = subprocess.Popen(
        cmd,
        stdout=subprocess.PIPE,
        stderr=subprocess.PIPE,
        shell=shell
        # Python 2 中指定编码（可选，根据系统调整）
        # close_fds=True  # Unix/Linux 下推荐，避免文件描述符泄漏
    )

    def worker():
        """子线程：等待子进程完成，获取输出"""
        result["stdout"], result["stderr"] = p.communicate()
        result["returncode"] = p.returncode
    
    # 启动子线程
    t = threading.Thread(target=worker)
    t.daemon = True  # 守护线程，主线程退出时自动销毁
    t.start()
    # 主线程等待超时时间
    t.join(timeout=timeout)

    if t.is_alive():  # 子线程仍在运行时，表示超时了，需要强制终止
        p.kill()  # 终止子进程（Windows/Linux 均支持）
        t.join()  # 等待子线程退出
        result["timeout"] = True
        raise Exception(u"命令执行超时（超过 {0} 秒）".format(timeout))
    else:  # 子进程正常结束
        return result

if __name__ == "__main__":
    # 测试超时场景（执行sleep 10，超时设为3秒）
    try:
        result = run_command_with_timeout(
            "/bin/sleep 10",  # Linux 命令（sleep 10秒）
            # "ping -n 30 127.0.0.1",  # Windows 测试命令（ping 10次，超时3秒）
            timeout=3,
            shell=True
        )
        print(u"stdout：{0}".format(result['stdout'].decode("gbk")))
        print(u"stderr：{0}".format(result['stderr'].decode("gbk")))
        print(u"returncode：{0}".format(result['returncode']))
    except Exception as e:
        print(u"Exception错误：{0}".format(e))




★math模块
import math
x = 2
math.sqrt(x)        # 返回x的平方根，float
math.pi             # 常量 pi=3.141592653589793
math.e              # 常量 e=2.718281828459045
math.log(x)        # 返回log x的值，以e为底
math.log10(x)      # 返回log10 x的值，以10为底
math.sin(x)        # 返回sin x的值，x为弧度，360度为2π弧度
math.cos(x)
math.tan(x)
math.pow(x,y)      #返回x的y次幂，同 x ** y



★random模块
import random
random.random()                   # 随机生成一个[0,1)范围内的实数，float
random.uniform(0, 5)             # 随机生成一个[0,5]范围内的实数，float
random.randint(0, 8)             # 随机生成一个[0,8]范围内的整数，int
random.randrange(1, 100, 2)       # 从[1到100]随机选一个整数，step默认为1，这里指定为2，即从1，3，5，7...选一个整数


★生成随机字符串
import string
import random

def generate_random_text(size):
    return ''.join(
        random.SystemRandom().choice(string.ascii_lowercase + string.ascii_uppercase + string.digits + string.punctuation) for _ in range(size))

print(generate_random_text(50))
string.ascii_letters 包含大小写字母

★glob文件通配符模块
import glob
print(glob.glob("*.py"))          # 返回由 当前目录下匹配上的文件名 组成的list




★pickle序列化模块
序列化是指将内存中的对象 存储到文件中（二进制文件）
反序列化将文件内容读出并生成对象（恢复成对象）
import pickle
datax = {"k1": "v1", "k2": "v2", "k3": "v3"}
datay = ["fdas", "fkldsj", 1323]
with open("pk.dat", "wb") as fp:
    pickle.dump(datax, fp)         # 一次存入一个对象，对象类型可不相同，但读出时得按相应顺序读出
    pickle.dump(datay, fp)

import pickle
with open("pk.dat", "rb") as fp:
    datax = pickle.load(fp)         # 一次读取一个对象，对象类型可不相同
    datay = pickle.load(fp)



★re正则匹配模块
RE（Regular Expression）正则表达式是 用来搜索目标字符串A 中的某些字符串s的，以及查询目标字符串s在A中的位置

正则表达式是由普通字符（例如字符 a 到 z）以及特殊字符（称为"元字符"）组成的文字模式

正则表达式用//包含起来（正则表达式写在//双斜杠之间）如 /xxxx/  里面的xxxx为正则表达式，（正则表达式本身不包含最外面那2个斜杠。在右边的/后面可带修饰符，如 /xxxx/igms
不过，在不同的文本编辑器或编程语言里，不是直接输入 /xxxx/igms 的，有的文本编辑器提供搜索框，可直接输入xxxx正则表达式，其他修饰符以“可选项”列出，需要时勾选相应修饰项即可

★正则表达式的修饰符
	i
	ignore，匹配时不区分大小写
	re.I

	g
	global，全局匹配，查找所有的匹配项
	

	m
	multi line，多行匹配，使得边界符^和$匹配每一行的开头和结尾，而不是整个字符串
	re.M

	s
	默认时 .点号 匹配除了换行符\n之外的所有字符，加上s修饰后，.点号包含换行符
	re.S



re.search()       #匹配整个字符串，直到找到一个匹配，只返回匹配上的第一个匹配对象<re.Match>
import re
str = "net Net fldskajfl jfsd lfjasd lfj asdkfl sl x"
ret = re.search(r"et", str, flags=re.I)    #在str里搜索 et，返回一个匹配对象，如果匹配不到，返回None
print(ret)
结果：
[image: ]
说明：
re.search(正则表达式, 要搜索的字符串, flags=修饰符)                    #只匹配第一个匹配上的字符
正则表达式    可用r" " 指定里面的所有字符都不识别为python转义字符
flags=         修饰符，可用 | 或运算连接多个修饰符，常用3个修饰符如下：
              re.I表示不区分大小写，re.M表示多行匹配，re.S表示使.点号匹配换行符
ret.span() 为一个tuple，匹配的起始字符index及终止字符index，含起始，不含终止
ret.group() 为匹配的一个群，一个匹配内容字符串
[image: ]
也可用ret.start()和ret.end()方法获取匹配到的起始位置及结束位置（含起始，不含结束）
[image: ]

re.findall(正则表达式, 要搜索的字符串, flags=修饰符)    #返回所有的匹配字符串<list>，元素为匹配的字符串
[image: ]

re.finditer(正则表达式, 要搜索的字符串, flags=修饰符)      #返回所有的匹配的结果，元素为<re.Match>
import re

str_xx = "ab001000bc000"
match_pattern = r'(?:0)+'
ret = re.finditer(match_pattern, str_xx, flags=re.I)
for ret_item in ret:
    print(type(ret_item))
    print(ret_item.span())
运行结果：
[image: ]



★base64模块
import base64

def test_base64():
    b64_str = 'aGVsbG8='
    decode = base64.b64decode(b64_str)  # base64解密后返回 str（bytes）
    print(decode)  # 结果为 'hello'
    bytes_like = 'hello'.encode('utf8')
    encode = base64.b64encode(bytes_like)  # base64加密内容必须为 str（bytes）
    print(encode)  # 返回 'aGVsbG8='

if __name__ == '__main__':
    test_base64()




★json模块
import json
dictx = {
    "k1": "v1",
    "k2": "vvv2",
    "k3": {"k3xx": "vdskl", "k3fyy": "fdksj"}
}
str_json = json.dumps(dictx)                 # 将字典数据转为json字符串，默认是一行
str2_json = json.dumps(dictx, indent=4)    # 将字典数据转为格式化的json字符串，缩进4空格
newdict = json.loads(str_json)               # 将json字符串导入解析为字典数据
with open("data.json", "w") as fp:
    json.dump(dictx, fp, indent=4)           # 将字典数据格式化为json字符串后写入到文件中
with open("data.json", "r") as fp:
    data = json.load(fp)             # 读取文件中的json字符串后生成字典数据（文件中只可有一个json对象）
    print(data)

import json

str_xx = r'{"name":"cof","age":18}'
data = json.loads(str_xx)  # ★将str类型的json字符串转为dict字典类型的数据
formatted_str = json.dumps(data, indent=4, sort_keys=True)  # sort_keys=True表示按键名排序输出
print(formatted_str)
结果：
{
    "age": 18,
    "name": "cof"
}

说明：读取字符串时使用json.loads()方法，读取文件时使用json.load()方法



★getpass模块
import getpass
cusername = getpass.getuser()               # 获取当前用户名
passwd = getpass.getpass("请输入密码：")    # 获取用户输入密码，不回显，该函数在IDLE/PyCharm里不生效



★uuid模块
import uuid
print(uuid.uuid1())                              # 返回uuid类，print则输出uuid字符串
print(uuid.uuid4().__str__())                  # 直接返回uuid字符串
uuid1使用到本服务器的一个网口mac地址，会泄露服务器的mac地址信息，不常用
uuid4使用时间加其他随便机数，常用



★sqlite3模块
import sqlite3

sqlite_conn = sqlite3.connect('test.db')  # 连接数据库文件，若文件不存在则新建
# 数据库所有数据存储在此文件中，默认数据库名称同文件名（不含.db后缀）
sqlite_cursor = sqlite_conn.cursor()  # 创建一个游标，用于执行sql语句

# 查询是否有名为'tb_test'的表
sqlite_cursor.execute(
    'SELECT * FROM sqlite_master WHERE "type"="table" and "tbl_name"="tb_test";')
result = sqlite_cursor.fetchall()  # fetchall()从结果中获取所有记录，返回一个list，元素为<tuple>（即查询到的结果）
print("tables: ", result)
if len(result) == 0:  # 若未查询到有此表，则创建此表
    sqlite_cursor.execute("create table tb_test (id varchar(36) NOT NULL PRIMARY KEY,name varchar(128),age int)")
try:
    sqlite_cursor.execute("insert into tb_test (id,name,age) values ('uuidxxxxxx','cof-lee',18)")
except Exception as e:
    print(type(e))  # 若在数据库中定义了唯一性约束，当试图插入一个重复的值时，会触发"sqlite3.IntegrityError"错误
    print(e)
    exit()
sqlite_cursor.execute("insert into tb_test (id,name,age) values ('uuidxxxxxx2','tom',19)")
sqlite_cursor.execute("insert into tb_test (id,name,age) values ('uuidxxxxxx3','ben',16)")
print("cursor rowcount", sqlite_cursor.rowcount)  # 游标上一次执行时返回的结果，刚插入一条数据，所以显示1
sqlite_cursor.close()
sqlite_conn.commit()  # 保存
sqlite_conn.close()  # 关闭连接

sqlite_conn2 = sqlite3.connect('test.db')  # 连接数据库（此时数据库文件已存在）
sqlite_cursor2 = sqlite_conn2.cursor()  # 创建一个游标，用于执行sql语句
sqlite_cursor2.execute("select * from tb_test limit 1000")
result = sqlite_cursor2.fetchall()  # fetchall()从结果中获取所有记录，返回一个list，元素为<tuple>（即查询到的结果）
print(result)

sqlite_cursor2.execute("select * from tb_test limit 1000")
result2 = sqlite_cursor2.fetchone()  # fetchone()从结果中获取一条记录，返回一个<tuple>（即查询到的结果）
print(result2)

sqlite_cursor2.execute("select * from tb_test limit 1000")
result3 = sqlite_cursor2.fetchmany(3)  # fetchone()从结果中获取多条记录（3条）返回一个list，元素为<tuple>（即查询到的结果）
print(result3)

sqlite_cursor2.close()
sqlite_conn2.close()  # 关闭连接



★sched模块
周期进行某任务，每隔一定时间就执行某任务
#!/usr/bin/env python
# -*- coding: UTF-8 -*-
import time
import sched

def schedule_func(index):
    print('index: {0} do schedule_func time {1}'.format(index, time.strftime("%Y-%m-%d %H:%M:%S", time.localtime())))
    time.sleep(1)

def loop_monitor():
    index = 0
    while True:
        sched1 = sched.scheduler(time.time, time.sleep)  # 创建一个调度器
        sched1.enter(3, 1, schedule_func, (index,))  # 延迟3秒，优先级1，回调函数，参数
        sched1.run()  # 运行调度器，默认是blocking=True，阻塞模式，等时间到了才运行，运行回调函数后才继续
        print(u'index: {0} 运行调度器回调函数之后的输出 {1}'.format(index, time.strftime("%Y-%m-%d %H:%M:%S", time.localtime())))
        index += 1

if __name__ == '__main__':
    loop_monitor()
结果：
index: 0 do schedule_func time 2025-12-10 09:29:48
index: 0 运行调度器回调函数之后的输出 2025-12-10 09:29:49
index: 1 do schedule_func time 2025-12-10 09:29:52
index: 1 运行调度器回调函数之后的输出 2025-12-10 09:29:53



★csv模块
读取csv文件：
csv文件名 test.csv  内容如下：
[image: ]
import csv
with open('test.csv', 'r') as file:
    reader = csv.reader(file)
    for row in reader:
        print(type(row))  # <class 'list'>
        print row[0], row[1], row[2]
结果：
<class 'list'>
vmname vmip groupid
<class 'list'>
coftest 10.99.1.1 2
<class 'list'>
test 10.99.2.2 2

写入文件：
# -*- coding: UTF-8 -*-

import csv

data = [
    ["name", "age", "class"],
    ["cof", 18, 1],
    ["lee", 19, 2]
]
with open('test2.csv', 'w') as file:
    writer = csv.writer(file, lineterminator="\n")  # lineterminator='\n'用来避免在写入时产生额外的空行
    writer.writerows(data)  # 写入多行数据
    writer.writerow(["wong", 17, 3])  # 写入单行数据
结果：
[image: ]




★第15章、常用非自带模块
常用的非自带模块，需要使用pip安装






★第16章、多进程与多线程
在python2.6之前python没有官方的线程池模块，只有第三方的theadpool模块，后来
python2.6加入了multiprocessing.dummy线程池
python3.2之后又加入了concurrent.futures模块，支持多线程及多进程；concurrent.futures底层还是用的threading和multiprocessing这2个模块，在其上又封装了一层。




★第17章、网络通信
★将域名解析为IP地址
①gethostbyname
import socket

def get_ip_by_domain(domain):
    ip = socket.gethostbyname(domain)
    return ip

print(get_ip_by_domain("www.cof-lee.com"))
结果：（返回一个ip地址，不论域名对应几个ip，只返回其中1个ip）
8.134.203.157


②getaddrinfo
# -*- coding: UTF-8 -*-
import socket

domain = "www.cof-lee.com"

try:
    addr_info = socket.getaddrinfo(domain, 0, socket.AF_INET, socket.SOCK_STREAM, socket.IPPROTO_TCP, socket.AI_ADDRCONFIG)
    # 返回一个列表，每个元素都是一个tuple元组，包含地址信息
    print(addr_info)
    first_addr_tuple = addr_info[0]  # 只取第1个ip信息tuple
    # 从地址信息元组中获取IP地址
    ip_address = first_addr_tuple[4][0]  # ip信息tuple是一个五元组(host, port)，第5个元素是一个tuple（ip, port），这里取ip
    print(ip_address)
except socket.gaierror as e:
    print(f"Error resolving domain {domain}: {e}")
结果：
[(<AddressFamily.AF_INET: 2>, <SocketKind.SOCK_STREAM: 1>, 6, '', ('10.99.1.69', 0)), (<AddressFamily.AF_INET: 2>, <SocketKind.SOCK_STREAM: 1>, 6, '', ('10.99.1.1', 0)), (<AddressFamily.AF_INET: 2>, <SocketKind.SOCK_STREAM: 1>, 6, '', ('10.99.1.233', 0))]
10.99.1.69

当域名对应多个IP地址时，getaddrinfo()会返回所有相关的地址信息，可以通过遍历addr_info来获取所有解析值
如果域名不存在或网络有问题，getaddrinfo()会抛出socket.gaierror异常。应该捕获这个异常并适当处理它。
socket.gaierror: [Errno 11001] getaddrinfo failed


③gethostbyname_ex
import socket

domain = "www.cof-lee.com"

name, aliaslist, addresslist = socket.gethostbyname_ex(domain)

print "name:", name
print "aliaslist:", aliaslist
print "addresslist:", addresslist
结果：
name: www.cof-lee.com
aliaslist: []
addresslist: ['10.99.1.1', '10.99.1.69', '10.99.1.233']




★TCP通信
★tcp-server
#!/usr/bin/env python
# -*- coding: UTF-8 -*-

import socket

host = "0.0.0.0"
port = 1234
sock1 = socket.socket(socket.AF_INET, socket.SOCK_STREAM)  # 创建socket，ipv4,tcp
sock1.bind((host, port))  # 监听的服务端ip,port，为一个元组
sock1.listen(5)  # 等待客户端连接
while True:
    con, addr = sock1.accept()
    print(u"客户端的地址为：{0}".format(addr))
    con.send(u"发给客户端的信息".encode("utf8"))  # 只能发送bytes
    con.close()
sock1.close()  # 关闭socket


★tcp-client
# -*- coding: UTF-8 -*-
import socket

host = "10.99.1.4"
port = 1234
sock1 = socket.socket(socket.AF_INET, socket.SOCK_STREAM)  # 创建socket，ipv4,tcp
sock1.connect((host, port))  # 连接服务端ip,port，为一个元组
recv = sock1.recv(1024)  # 接收对端发来的数据，最多收1024字节，返回bytes
print(recv.decode("utf8"))
sock1.close()  # 关闭socket





★UDP通信
★udp-server
# -*- coding: UTF-8 -*-
import socket

addr_ser = ("0.0.0.0", 1234)
sock1 = socket.socket(socket.AF_INET, socket.SOCK_DGRAM)  # 创建socket，ipv4,udp
sock1.bind(addr_ser)  # 监听的服务端ip,port，为一个元组
while True:
    data, addr = sock1.recvfrom(1024)  # 接收客户端发来的数据，最多1024字节
    print u"客户端的地址为：", addr
    print u"客户端发来的数据：", data
    sock1.sendto(u"发给客户端的信息".encode("utf8"), addr)
sock1.close()  # 关闭socket


★udp-client
# -*- coding: UTF-8 -*-
import socket

addr_ser = ("127.0.0.1", 1234)
sock1 = socket.socket(socket.AF_INET, socket.SOCK_DGRAM)  # 创建socket，ipv4,tcp
sock1.sendto(u"发送给server的数据".encode("utf8"), addr_ser)
recv = sock1.recv(1024)  # 接收对端发来的数据，最多收1024字节，返回bytes
sock1.close()  # 关闭socket








★附录（ascii码）
字符编码相关知识请参阅作者的“汉字标准及字符编码探究”
链接：https://limaofu.github.io/t3doc/汉字标准及字符编码探究-back-250928.docx

★ASCII码表
	数字
	Hex
	含义
	数字
	Hex
	含义
	数字
	Hex
	含义
	数字
	Hex
	含义
	数字
	Hex
	含义

	0
	00
	NUL
	26
	1A
	SUB
	52
	34
	4
	78
	4E
	N
	104
	68
	h

	1
	01
	SOH
	27
	1B
	ESC
	53
	35
	5
	79
	4F
	O
	105
	69
	i

	2
	02
	STX
	28
	1C
	FS
	54
	36
	6
	80
	50
	P
	106
	6A
	j

	3
	03
	ETX
	29
	1D
	GS
	55
	37
	7
	81
	51
	Q
	107
	6B
	k

	4
	04
	EOT
	30
	1E
	RS
	56
	38
	8
	82
	52
	R
	108
	6C
	l

	5
	05
	ENQ
	31
	1F
	US
	57
	39
	9
	83
	53
	S
	109
	6D
	m

	6
	06
	ACK
	32
	20
	空格
	58
	3A
	:
	84
	54
	T
	110
	6E
	n

	7
	07
	BEL
	33
	21
	!
	59
	3B
	;
	85
	55
	U
	111
	6F
	o

	8
	08
	BS
	34
	22
	"
	60
	3C
	<
	86
	56
	V
	112
	70
	p

	9
	09
	HT
	35
	23
	#
	61
	3D
	=
	87
	57
	W
	113
	71
	q

	10
	0A
	LF
	36
	24
	$
	62
	3E
	>
	88
	58
	X
	114
	72
	r

	11
	0B
	VT
	37
	25
	%
	63
	3F
	?
	89
	59
	Y
	115
	73
	s

	12
	0C
	FF
	38
	26
	&
	64
	40
	@
	90
	5A
	Z
	116
	74
	t

	13
	0D
	CR
	39
	27
	'
	65
	41
	A
	91
	5B
	[
	117
	75
	u

	14
	0E
	S0
	40
	28
	(
	66
	42
	B
	92
	5C
	\
	118
	76
	v

	15
	0F
	S1
	41
	29
	)
	67
	43
	C
	93
	5D
	]
	119
	77
	w

	16
	10
	DLE
	42
	2A
	*
	68
	44
	D
	94
	5E
	^
	120
	78
	x

	17
	11
	DC1
	43
	2B
	+
	69
	45
	E
	95
	5F
	_
	121
	79
	y

	18
	12
	DC2
	44
	2C
	,
	70
	46
	F
	96
	60
	`
	122
	7A
	z

	19
	13
	DC3
	45
	2D
	-
	71
	47
	G
	97
	61
	a
	123
	7B
	{

	20
	14
	DC4
	46
	2E
	.
	72
	48
	H
	98
	62
	b
	124
	7C
	|

	21
	15
	NAK
	47
	2F
	/
	73
	49
	I
	99
	63
	c
	125
	7D
	}

	22
	16
	SYN
	48
	30
	0
	74
	4A
	J
	100
	64
	d
	126
	7E
	~

	23
	17
	ETB
	49
	31
	1
	75
	4B
	K
	101
	65
	e
	127
	7F
	DEL

	24
	18
	CAN
	50
	32
	2
	76
	4C
	L
	102
	66
	f
	
	
	

	25
	19
	EM
	51
	33
	3
	77
	4D
	M
	103
	67
	g
	
	
	




特殊字符表示：
	转义
	hex十六进制
	vt表示
	含义

	\07
	07
	^G
	BEL  响铃

	\010
	08
	^H
	BS  退格，光标左移一格

	\t
	09
	^I
	HT  水平制表符

	\v
	0B
	^K
	VT  垂直制表符

	\r
	0D
	^M
	CR  回车，光标移动到行首

	\n
	0A
	^J
	LF  换行，光标移动到下一行

	\032
	1A
	^Z
	SUB  EOF

	\033
	1B
	^[
	ESC




1961年美国国家标准局(ANSI)制定了ASCII码（American Standard Code for Information Interchange，美国标准信息交换码），它已被国际标准化组织（ISO）定为国际标准，称为ISO 646标准，标准ASCII码为7位，扩充为8位（最高位为0）

7位二进制数可以表示(2^7)==128个数字（0到127），每个数字都唯一地对应一个字符，这些数字就是对应字符的编码，ASCII编码对应 控制字符及可打印字符：
0～32号及第127号（共34个）是控制字符或通讯专用字符（32号为空格）
33～126号（共94个）是可打印字符

ASCII码主要是给美国用的（英语文字），欧洲及亚洲其他国家的文字符号不在ACSII的收录范围内，于是他们把ASCII扩展了，使用8位的ASCII，把最高位置1，这样比原来的ASCII又多出128个编码可分配，不同的国家甚至厂商都有自己的标准，不利于规范，于是国际标准化组织（ISO）和国际电工委员会(IEC)联合制定了一系列8位字符集的标准：ISO 8859，全称ISO/IEC 8859

ISO/IEC 8859-1 (Latin-1)   西欧语言
ISO/IEC 8859-2 (Latin-2)  中欧语言
ISO/IEC 8859-3 (Latin-3)   南欧语言。世界语也可用此字符集显示。
ISO/IEC 8859-4 (Latin-4)   北欧语言
ISO/IEC 8859-5 (Cyrillic)   斯拉夫语言
ISO/IEC 8859-6 (Arabic)   阿拉伯语
ISO/IEC 8859-7 (Greek)    希腊语
ISO/IEC 8859-8 (Hebrew)   希伯来语(视觉顺序)
ISO/IEC 8859-8-I (Hebrew)  希伯来语(逻辑顺序)
ISO/IEC 8859-9 (Latin-5 或 Turkish)   它把Latin-1的冰岛语字母换走，加入土耳其语字母
ISO/IEC 8859-10 (Latin-6 或 Nordic)   北日耳曼语支，用来代替Latin-4
ISO/IEC 8859-11 (Thai)   泰语，从泰国的 TIS620 标准字集演化而来
ISO/IEC 8859-13 (Latin-7 或 Baltic Rim)   波罗的语族
ISO/IEC 8859-14 (Latin-8 或 Celtic)   凯尔特语族
ISO/IEC 8859-15 (Latin-9)   西欧语言，加入Latin-1欠缺的芬兰语字母和大写法语重音字母，以及欧元符号
ISO/IEC 8859-16 (Latin-10)   东南欧语言。主要供罗马尼亚语使用，并加入欧元符号
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